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1   Release contents

1.1  Version 24.12 (January 2025)
• Upgraded: Newer LinkServer software (v24.12.21).
• Upgraded: Newer SEGGER J-Link software (v8.12a).
• Upgraded: Newer PEmicro plugins (v5.9.5).
• Upgraded: Version v24.12 of MCUXpresso Config Tools.
• Feature: [LinkServer] Upgraded MCU-Link version to 3.152.
• Feature: Feature: Support for KW47, MCXW72 devices, and KW47-EVK, KW47-LOC, MCX-W72-EVK,

FRDM-MCXW72, MCX-W72-LOC boards.
• Feature: Support for MCXA165, MCXA166, MCXA175, MCXA176, MCXA275, and MCXA276 devices.
• Feature: Support for MIMXRT700.
• Feature: [SDK Integration] Synchronization with SDK v24.12.

Note: Only MCUXpresso IDE packages downloaded from mcuxpresso.nxp.com are supported. GitHub SDK
format is currently not supported.

• Feature: [IDE] Automatic probe selection and device/board verification when using CMSIS-DAP-based probes
with target information available.

• Improvement: [IDE] When importing multiple projects and no associated installed SDK is found, show only
one dialog message dialog listing all projects and missing SDKs. Install MCUXpresso SDKs view can then be
opened from the dialog.

• Fixed: [IDE] The SDK details associated with a project are not updated after associating other compatible
SDK.

• Fixed: [IDE] Project Settings node from Project Explorer shows incorrect SDK version once associating other
SDK with project.

• Fixed: [SDK Integration] Preprocessor defines might be incorrect when importing some example projects that
are linked to other projects.

• Fixed: [Debug][J-Link] Restart for RAM debug does not work for some MCUs when using J-Link.
• Fixed: [Application Code Hub] Some projects might not be recognized as valid MCUXpresso IDE projects

because they do not use the NXP GitHub.

1.2  Version 24.09 (September 2024)
• Upgraded: Newer LinkServer software (v24.9.75).
• Upgraded: Newer SEGGER J-Link software (v8.10).
• Upgraded: Newer PEmicro plugins (v5.9.2).
• Updated: Version v16.1 of MCUXpresso Config Tools.
• Feature: [SDK Integration] Synchronization with SDK v2.16.100.
• Feature: [LinkServer] Upgraded MCU-Link version to 3.148.
• Feature: [LinkServer] Added initial support for MIMXRT700.
• Feature: [LinkServer] Added LinkServer flash programming utility for executing flash operations using

the graphical user interface. Refer to docs/LinkFlash.md from LinkServer installation for additional details
regarding the GUI flash support.

• Feature: [LinkServer] Added LinkServer application runner for use in CD/CI testing environments.
• Feature: [LinkServer] LinkServer flash load and flash verify commands now accept multiple files as

arguments.
• Improvement: [IDE] Generated linker scripts now reference the BSD-3-Clause license.
• Improvement: [IDE] The IDE is now capable to update the MCU-Link probes firmware by retrieving the latest

compatible firmware from nxp.com.
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• Improvement: [LinkServer] Binaries are now compiled as 64-bit applications on Windows.
• Improvement: [LinkServer] Install x86 and x64 versions of Microsoft Visual C++ Redistributable on Windows.
• Improvement: [LinkServer] Added MCXN9xx FlexSPI flash driver to examples.
• Improvement: [LinkServer] Added disable GDET sequence to MCXN9xx and MCXN5xx preconnect scripts.
• Improvement: [LinkServer] Added standalone entries (no board) for MCXN9xx, MCXN5xx, MCXN2xx,

MCXA1xx devices.
• Fixed: [FreeRTOS] Runtime percentage is always 0 inside Tasks view for FreeRTOS v10 (non-SMP).
• Fixed: [LinkServer] MCXN9xx FlexSPI flash driver problem (reproducible on some FRDM-MCXN947 boards).
• Fixed: [LinkServer] RT1020, RT1160/RT1170/RT1180 flash drivers in SDP mode.

1.3  Version 11.10.0 (July 2024)
• Upgraded: Eclipse version to 2023.12 (Eclipse Platform 4.30.0 / CDT 11.4.0).
• Upgraded: GNU ARM Embedded Toolchain to version 13.2.Rel1.

Note1: Debugging info is enforced to DWARF version 4 ("-gdwarf-4").
Note2: The IDE no longer uses the "-ffreestanding" compiler flag when creating projects with NPW. GNU GCC
13 does not allow anymore the inclusion of non-freestanding library headers in freestanding environments.

• Upgraded: ARM CMSIS-Pack Eclipse Plug-ins 2.9.0.
• Upgraded: Newer xPack Windows Build Tools (v4.4.1-2).
• Upgraded: Newer LinkServer software (v1.6.133).
• Upgraded: Newer SEGGER J-Link software (v7.96o).
• Upgraded: Newer PEmicro plugins (v5.8.2).
• Upgraded: Version v16 of MCUXpresso Config Tools.
• Added debug support for MCXA156 device and FRDM-MCXA156 board.
• Added debug support for MCXW71x device and FRDM-MCXW7X board.
• Added debug support for MCXC041, MCXC242 and MCXC444 devices and the respective FRDM-MCXC041,

FRDM-MCXC242 and FRDM-MCXC444 boards.
• Updated debug support for RW612 rev A2 silicon.
• Feature: [Documentation] Update to new format according to latest NXP guidelines.
• Feature: [IDE] Rework Other Symbols tab on a launch configuration to add possibility to download extra

images.
• Feature: [IDE] MCU-Link probes firmware can now be updated automatically from within Probes Discovered

dialog.
• Feature: [IDE] Use a J-Link path configuration section similar to LinkServer (see J-Link Preferences page).
• Feature: [IDE] Add support for displaying .md (markdown format) files.
• Feature: [FreeRTOS v11] Add preliminary support in TAD views in LinkServer GDB thread awareness.
• Feature: [Zephyr RTOS] Add TAD views for timers, mutexes, events and semaphores.
• Feature: [SDK Handling] Add preference to control refresh of available remote plugin SDKs at IDE startup.
• Feature: [Toolchain integration] Inform about "freestanding" usage and about the changes brought by GCC

13. Markers are created in Problems view.
• Feature: [Linux Installer] Add an explicit user consent regarding installation of udev rules.
• Improvement: [IDE] Show warning about invalid or incompatible LinkServer at IDE startup.
• Improvement: [IDE][NPW] Projects created using the New Project Wizard no longer contain the device-

specific include in the main source file.
• Improvement: [IDE][SDK Handling] SDKs installed through the "Install MCUXpresso SDKs" are no longer

installed using the P2 Eclipse mechanism. They are installed as file system SDKs instead.
• Improvement: [IDE][SDK Handling] Complete cleanup after uninstalling a GitHub SDK.
• Improvement: [IDE][Toolchain integration] Allow managing C++ include paths from Quickstart Panel => Quick

Settings.
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• Improvement: [IDE][Toolchain integration] Revise enforcement of DWARF 4 in imported projects.
• Improvement: [IDE][Application Code Hub] Offer to install missing SDK used by projects imported after

cloning a remote repository.
• Improvement: [IDE] Better layout for multicore-related filtering controls in PEmicro preferences page.
• Improvement: [IDE] Support Eclipse variables for J-Link script file inside launch configuration.
• Improvement: [Linux Installer] LinkServer deb installers now install a versioned product, allowing multiple

product instances.
• Improvement: [Linux Installer] Allow installation even without libncurses5/libncursesw5 (build tools

dependencies).
• Improvement: [Windows Installer] Better handling of systems with case sensitive enabled paths.
• Fixed: [IDE] When using absolute paths for artifact names, intermediate .args response files for linker/archiver

are not generated.
• Fixed: [IDE] Custom LinkServer path not taken into account when launching redlinkserv.
• Fixed: [IDE][Command line] Eclipse returns non-zero exit code when building project without having the

associated SDK installed.
• Fixed: [IDE][GUI Flash Tool] Preserve connect script field when switching tabs.
• Fixed: [IDE][Trace] Instruction trace configuration fails to correctly link/chain watchpoints comparators.
• Fixed: [RTOS] "Unknown" task names in the FreeRTOS tasks list view after stepping from "main".
• Fixed: [MQX][LinkServer] GDB thread awareness fails to show and debug 23+ threads.
• Fixed: [Debug][LinkServer] Problems related to evaluation of complex expressions in LinkServer scripts (.scp).
• Fixed: [Debug][LinkServer] Increased the maximum number of supported probes in Redlink Server from 8 to

16.
• Fixed: [Debug][LinkServer] Fix a problem related to restart after flash load.
• Fixed: [Debug][LinkServer] Problems related to soft reset for MIMXRT1170 and MIMXRT1160 when

debugging Cortex-M4 applications in RAM.
• Fixed: [Debug][PEmicro][MCXN2xx] TrustZone projects cannot be reliably debugged with PEmicro probes.
• Fixed: [Debug][PEmicro][MCXN5xx] Flash driver for external QSPI flash is not available, thus programming/

debugging fails.
• Fixed: [Debug][PEmicro] Step over does not work after restart and after reading the list of FreeRTOS tasks.
• Fixed: [Debug][J-Link][RT1170] Unable to program a CM4 flash image.
• Fixed: [SDK Integration] Compilation might fail after adding/refreshing certain SDK components from IDE

(depending on SDK definition).
• Fixed: [SDK Integration] Mutually exclusive dependencies are not handled correctly.
• Fixed: [SDK Integration] Incorrect handling of project template components for imported SDK examples.
• Fixed: [SDK Integration] Config files contributed by components are incorrectly handled when example

projects already contain the same configuration files.
• Fixed: [SDK Integration] NPW now properly considers device_core dependencies, preventing incorrect

component addition for the wrong core.
• Fixed: [Windows Installer] Cannot open the documentation page from the shortcut available in the Start menu.

1.4  Version 11.9.1 (April 2024)
• Upgraded: Newer LinkServer software (v1.5.30).
• Upgraded: Newer SEGGER J-Link software (v7.96c).
• Upgraded: Newer PEmicro plugins (v5.7.8).
• Updated: Version v15.1 of MCUXpresso Config Tools.
• Added: Debug support for MCXA156.
• Improvement: [IDE] Support Eclipse variables for J-Link script file inside launch configuration.
• Fixed: [KW45/K32W1][J-Link] Debug after flash erase does not work.
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• Fixed: [IDE][SDK Handling] Automatic import of plugin SDKs returns an error if the IDE isn't installed in the
default location.

• Fixed: [IDE][SDK Handling] Automatic import of plugin SDKs fails to import some SDKs.
• Fixed: [IDE][Config Tools Integration] Fix some performance issues.
• Fixed: [IDE][Welcome page] Release notes text shown in What's New section might be incorrectly rendered.

1.5  Version 11.9.0 (January 2024)
• Upgraded: Eclipse version to 2023.06 (Eclipse Platform 4.28.0 / CDT 11.2.0).
• Upgraded: MCUXpresso IDE integrated with OpenJDK Runtime Environment Temurin-17.0.7+7.
• Upgraded: GNU ARM Embedded Toolchain to version 12.3.Rel1. Note: Debugging info is enforced to

DWARF version 4 ("-gdwarf-4").
• Upgraded: ARM CMSIS-Pack Eclipse Plug-ins 2.9.0.
• Upgraded: Newer SEGGER J-Link software (v7.94b).
• Upgraded: Newer PEmicro plugin (v5.7.6).
• Upgraded: Version v15 of MCUXpresso Config Tools.
• Added: Initial support for MCXN2xx devices and FRDM-MCXN236 board.
• Feature: [MCXN9xx] Update debug support for A1 silicon.
• Feature: [App Code Hub] The IDE now offers views and wizards that allow users to import projects by directly

interacting with the Application Code Hub website. Feature is accessible through:
– The File -> Import -> Application Code Hub wizard
– The dedicated Quickstart link, by opening the view using Window -> Show View -> Other -> Application

Code Hub
– Or by using Help -> Additional Resources -> Application Code Hub menu entry

• Feature: [SDK Integration] Synchronization with SDK v2.15.abc and manifest schema version 3.14.
• Feature: [SDK Integration] Support complex dependencies for board, core, device, toolchain, compiler.
• Feature: [SDK Integration] Support the new "template" type of SDK component containing predefined code

snippets, visible to users in the UI of the new project wizard and component manager to allow users to add
the files with the snippets into projects. Also, added CLI support for this type by "use.all.templates" property
for the "example.build" and "project.build" commands. By default, the option is set to false, so no template
source is added to the project.

• Feature: [SDK Integration] Existing Import Remote SDK Git repository flow improved - a wizard is now used to
clone and import the SDK.

• Feature: [SDK Integration] Automatic import of plugin SDKs from previous IDEs versions when upgrading to a
newer version.

• Feature: [SDK Integration] Add "change.sdk.roots" command in CLI mode that allows updating the built-in
SDK search locations.

• Feature: [RT1160/RT1170/RT1020] Update flashloaders to work with non-default dummy cycle values.
• Feature: The MCUXpresso IDE installer now installs the LinkServer debug solution as a separate tool.

Support files from the IDE that were LinkServer-specific are now part of the actual LinkServer package. The
IDE implicitly uses the automatically installed LinkServer but a custom LinkServer can be configured using
the Preferences page. A symbolic link to the installed LinkServer is also created inside the IDE layout (see
<MCUXpressoIDE>/ide/LinkServer).

• Improvement: [IDE] Make Welcome page theme-aware and create content for dark theme.
• Improvement: [IDE] Speed-up automatic generation of Makefiles.
• Improvement: [Windows installer] Disabled maximum path length limitation.
• Improvement: [Windows installer] Install J-Link USB drivers on Windows (starting with the J-Link V7.92l

installer, drivers are no longer installed by default).
• Improvement: [SDK Integration] Reduced GitHub SDK loading time when starting the IDE.
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• Improvement: [NPW/Manage SDK Components] Optimized component selection, minimizing time and
eliminating freezes when selecting several components.

• Improvement: [NPW] Performance improvements when changing core selection.
• Fixed: [IDE] If the SDK required by the project is not installed, too many identical confirmation windows

appear.
• Fixed: [IDE] J-Link RAM debug sessions fail to set PC and SP correctly.
• Fixed: [IDE / Toolchain integration] The IDE automatically switches to using response files inside the

generated linker command, for command lines exceeding 32 K in length. Behavior is specific to Windows
hosts, where there is a 32K length limit for a command line.

• Fixed: [IDE / Toolchain integration] The archiver exits with error code when lots of object files are passed to
the tool. IDE now passes object files through response files when the command line exceeds 32 K in length.

• Fixed: [SDK Integration] Recreating or uninstalling a GitHub SDK deletes the manifest file from the repository
and breaks the SDK.

• Fixed: [NPW] Link section memory range used by the secondary Multicore project specified during project
creation is not reflected in final project settings.

• Fixed: [RT1180 B0] Semihosting PRINTF does not work properly with LinkServer when the heap is located in
cacheable memory.

• Fixed: [RT1180 B0] Connect script leaves DMA4 controller with error status indication.

1.6  Version 11.8.1 (October 2023)
• Upgraded: Newer SEGGER J-Link software (v7.92l).
• Upgraded: Newer PEmicro plugin (v5.7.3).
• Added: Support for i.MX RT1180 device and MIMXRT1180-EVK board.
• Added: Support for KE1xZ512 devices and X-FRDM-KE17Z512 board.
• Added: Support for MCXA153 device and FRDM-MCXA153 board.
• Improvement: [Toolchain Integration] Added C++20 and C++23 entries in the list of supported compiler

dialects.
• Fixed: [Debugger][RW61x] Connect script does not halt after SYSRESET when a secure project is in flash.
• Fixed: [Flash Programmer] Some problems related to flash blank command.
• Fixed: [SDK Integration] Device-specific preprocessor defines are not taken in consideration when changing

the device package.

1.7  Version 11.8.0 (July 2023)
• Upgraded: Eclipse version to 2022.12 (Eclipse Platform 4.26.0 / CDT 11.0.0).
• Upgraded: MCUXpresso IDE integrated with OpenJDK Runtime Environment Temurin-17.0.5+8.
• Upgraded: GNU ARM Embedded Toolchain to version 12.2.Rel1.
• Upgraded: Version v14 of MCUXpresso Config Tools.
• Upgraded: ARM CMSIS-Pack Eclipse Plug-ins 2.8.0.
• Upgraded: Newer SEGGER J-Link software (v7.88m).
• Upgraded: Newer PEmicro plugin (v5.6.7).
• Synchronization with SDK v2.14.x.
• Added support for MCXN9xx devices.
• Added support for RW61x devices.
• Feature: New IDE build for Mac with native Apple silicon support. See the download section for the new

product.
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• Feature: LinkServer LPC-Link2 firmware now softloaded as v5.460, which offers support for powering certain
RT1xxx EVK boards (which incorporate on-board debug probes based on LPC-Link2 hardware) through the
USB debug connection.

• Feature: [Open-CMSIS-Pack] Extended integration with ARM CMSIS-Pack Eclipse Plug-ins. Now, adding a
new Open-CMSIS-Pack component is managed by the ARM CMSIS-Pack Eclipse Plug-in. Note: If a project
was created with the previous version of Open-CMSIS-Pack support, you'll be asked to remove or to keep the
added components. Choosing "keep" involves preserving sources only, not the links with Open-CMSIS-Pack
Manager. If you need to have them managed by ARM CMSIS-Pack Eclipse Plug-in (for the above-mentioned
available features) choose "remove" and add them back. This brings support for:
– Components dependency
– Multiple component selection
– Automatically check dependencies in the new multiple component selection view
– Copy configuration and template files to the project

• Feature: Added support for selecting library type in SDK CLI. Now redlib, newlib, newlib_nano can be selected
as options when generating a project. Check MCUXpresso_IDE_Command_Line_User_Guide.pdf for details.

• Improvement: [SDK Integration] Allow the possibility to switch a project from one MCU device to another.
• Improvement: [SDK Integration] Reduced time required to import examples from zipped SDKs.
• Improvement: [SDK Integration] Optimize initial SDK GitHub cloning time by deferring cloning of examples

until needed.
• Improvement: [Debugger] Discover Probes dialog warns if using MCU-Link probes running firmware, which is

incompatible with the current IDE version.
• Improvement: [Debugger] Add possibility to disable auto-debug of secondary project based on the target

name in Debug Options preferences.
• Improvement: [RTOS] Add preferences to control enablement of RTOS TAD logging consoles. This prevents

showing up unwanted or not used consoles. Go to Preferences -> MCUXpresso IDE -> RTOS TAD ->
(Desired) RTOS -> Logging configuration and select or unselect "Create logging console and log messages
from TAD plugin".

• Improvement: [SWO] Error caused by input in the ITM console should now also be displayed inside the
console.

• Improvement: [IDE][Quickstart Panel] Added link to executable import wizard in Quickstart Panel.
• Improvement: [IDE] Add 'bash' shell executable in buildtools/bin folder on Windows.
• Improvement: [Installer] Support silent installation for Linux installers (deb.bin packages). This can be

executed using: <install_package>.deb.bin -- --acceptLicense.
• Fixed: [SDK Integration] Unexpected disk space consumption at "Refresh" operation.
• Fixed: [SDK Integration] Error reported when creating a project from GitHub SDK with a board selection from

a standalone SDK.
• Fixed: [SDK Integration] Include Paths list is duplicated after refreshing SDK components.
• Fixed: [SDK Integration] New Project Wizard incorrectly computes anyOf dependency for multicore

component.
• Fixed: [SDK Integration] C startup file is incorrectly added in C++ project after refreshing SDK components.
• Fixed: [SDK Integration] App SW Packs fail to import on IDE starting with IDE v11.7.0 and SDK v2.12 and

v2.13.
• Fixed: [SDK Integration] Exception error is displayed when the user scrolls in the component list from the SDK

Wizard window.
• Fixed: [SDK Integration] Cloning more than one GitHub SDK repository makes the second repository

unusable.
• Fixed: [SDK Integration] Deselecting components with dependencies doesn't display warnings.
• Fixed: [SDK Integration] Unable to deactivate an already installed Git SDK repository from the Installed SDKs

view.
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• Fixed: [SDK Integration] Build error is obtained when some specific components (serial_manager_*) are
changed from SDK Management -> Manage SDK Components view.

• Fixed: [SDK Integration] Progress is incorrectly reported in NPW and SDK Import Wizard.
• Fixed: [SDK Integration] Importing projects can introduce wrong dependencies between SDK components,

which result in build failure.
• Fixed: [Toolchain integration] Sometimes, building some projects is shown as failed due to linker warnings

misinterpreted as errors.
• Fixed: [Toolchain Integration] Projects are always rebuilt after restarting the IDE.
• Fixed: [Executable Importer] Cannot use Binary Utilities with the imported ELF.
• Fixed: [Managed Linker Script] Sometimes .bss sections are unexpectedly part of the output bin/s19 images.

These are now declared as NOLOAD in the linker scripts.
• Fixed: [Flash Programmer] KW45B41Z board should not have Resurrect locked Kinetis device option.
• Fixed: [Flash Programmer] Flash tool not writing .flash_config section from ELF.
• Fixed: [Debug][LPC55S36 A1] Restart does not work.
• Fixed: [Debug] Null pointer exception when creating a launch config for LinkServer.
• Fixed: [Debug] Broken SWO functionality on non-LPC-Link2/MCULink probes (Arm ULINKplus).
• Fixed: [Debug][Multicore] "Step Return All Debug sessions" throws an error while in source code.
• Fixed: [Debug][ARMv6-M] The default VECTRESET set for flash reset has no effect since it is not supported

for ARMv6-M MCUs. Use SOFT reset instead.
• Fixed: [Debug][PEmicro&Linkserver] GUI Flash Tool fields are prefilled with wrong information for PEmicro

when a debug launch is previously created, or are not implemented when using LinkServer debug probes.
• Fixed: [Debug][PEmicro] TrustZone projects cannot be debugged because non-secure image is not

programmed in flash.
• Fixed: [Debug][LinkServer] Semihosting operations fail while the debugger is detached and can fail to recover

when reattaching.
• Fixed: [Debug][LinkServer] Various semihosting operations fail when using a LinkServer debug probe.
• Fixed: [Debug][LinkServer][SWO] Support for SWO trace using CMSIS-DAP1.1 SWO probes is broken.
• Fixed: [Debug][Linkserver] Debug session launch is slow on LinkServer compared to other probes on some

Windows PCs.
• Fixed: [Debug][Linkserver] Cannot boot LPC-Link1 when a LPC-Link2 probe configured for DFU booting is

also present.
• Fixed: [Energy Measurement] View must not allow attaching to debug session on targets missing

measurement support.
• Fixed: [Energy Measurement] Sometimes. an error appears when successively connecting various probes

and using "Out of debug" mode.
• Fixed: [FreeRTOS] Exception occasionally encountered when resuming or pausing the debug session of a

FreeRTOS project with non-stop gdb option disabled and Peripherals Window open.
• Fixed: [FreeRTOS] In the 'freertos_hello' example application, the 'hello' task is shown as "Running" even

before having the scheduler running.
• Fixed: [SWO] When the SWO Counters view is resumed, the SWO Data view is resumed automatically.
• Fixed: [IDE] IDE Linker File Parser fails for question mark operator.
• Fixed: [IDE] Update icons to address some problems on dark theme and high DPI (macOS Retina) displays.

1.8  Version 11.7.1 (March 2023)
• Upgraded: Newer SEGGER J-Link software (v7.86e).
• Upgraded: Newer PEmicro plugin (v5.5.5).
• Upgraded: Version v13.1 of MCUXpresso Config Tools.
• Added support for LPC553x/S3x revision A1 device.
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• Added support for LPC860 revision A1 device.
• Added support for KW45/K32W1 revision A2 device.
• Improvement: [SWO] Added preference for SWO ITM rxBuffer reading timeout in Preferences ->

MCUXpresso IDE -> SWO Trace -> ITM_RxBuffer send timeout. This is intended to allow timeout increase
when the user determines the application is not able to consume the full amount of (so it appears to lose) data
sent by the host debugger with the current timeout settings.

• Fixed: [Debug] Can't create a new launch configuration after using the GUI Flash Tool on PEmicro.
• Fixed: [X-KW45B41Z-EVK][MCU-Link] Debug error reported when using MCU-Link firmware 3.x.
• Fixed: [Debug][PN7642] Update reset script to fix Restart behavior in the IDE (not fully performing reset on

certain clocks/peripherals).
• Fixed: [Energy Measurement][Power Profile] Trigger configuration is visible for LPC-Link2 probes.
• Fixed: [SWO] Starting a debug session with SWO counters or interrupts views opened results in an error.

1.9  Version 11.7.0 (January 2023)
• Upgraded: Eclipse version to 2022.06 (Eclipse Platform 4.24.0 / CDT 10.7.0).
• Upgraded: MCUXpresso IDE integrated with JRE Eclipse Temurin (HotSpot engine, build 11.0.17+8)
• Upgraded: Windows 10/11 version 22H2 and macOS 13 (Ventura) support.
• Upgraded: Version v13 of MCUXpresso Config Tools.
• Upgraded: Synchronization with SDK v2.13.x.
• Upgraded: Newer SEGGER J-Link software (v7.84a).
• Upgraded: Newer PEmicro plugin (v5.4.1).
• Added MIMXRT1170-EVKB board support.
• Added K32W1, KW45, PN7642 devices support. Note. [KW45] Because ECC RAM is enabled by default,

debugging an application in RAM is not guaranteed to work if the application image contains unaligned
sections. In order to avoid this situation, be sure at least one of the following rules is considered:
– Enable the ECC RAM initialization in the connect script (<layout>/ide/binaries/Scripts/KW45B41_connect.

scp - see the comment from line 6).
– Use at least 4-byte aligned data structures/variables.

• Feature: [LinkServer] Support MCU-Link probes running V3.x firmware versions (based on CMSIS-DAP 2.1,
using bulk/WinUSB endpoints). Note that MCU-Link probes must be updated to version 3.x in order to be
used with this version of the IDE.

• Feature: [Boot Configuration] Added Target Boot Control option (in LinkServer launch configuration) to
configure device boot mode on the reset requests (issued during a debug session). This feature is only
available on MCU-Link debug probes having ISPx boot control features implemented. See "Changing target
boot configuration" section from User Guide.

• Feature: [Open-CMSIS-Pack] Added possibility to explore Open-CMSIS packs and import (middleware)
components into an Eclipse project. Note: in the current version of the feature, users shall manually add
component dependencies. A future version will automatically resolve dependencies and add them to the
project:
– Set a path to work with Open-CMSIS Packs: Preferences -> CMSIS-Packs -> CMSIS-pack root folder (you

can let the existing one as default)
– Load/Download/Import Packs: Perspective -> Open Perspective -> Other -> CMSIS-Pack Manager. From

Packs view (toolbar) you can: Reload, Check for updates on Web, Import Packs from disc, and so on.
– Once the desired packs are available, you can add them into the Eclipse project by right-clicking on the

project entry in Project Explorer -> SDK Management -> Add components from Open-CMSIS-Pack and
select the desired one from the "Add Open-CMSIS component to project" wizard. The component is then
available on Project Explorer view (the sources being linked to the original pack location), and also on
Project Settings with details about its hierarchical path.
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– Components can be deleted from the project by selecting the component from Project Explorer -> < select
project > -> Project Settings -> Open-CMSIS components, right-click on it, and choose "Delete Open-
CMSIS component".

• Feature: [SDK Integration][SDK GitHub] Added support for paths relative to the manifest file inside the
example projects.

• Feature: [Elf Importer] Import ELF binary/executable. This feature is available from File -> Import -> C/C++ ->
MCUXpresso Executable Importer.

• Feature: [MQX RTOS] Support for MQX RTOS GDB thread awareness to allow multithread debugging. Task
Aware Debug (TAD) views in Eclipse will be added in a future IDE version.

• Feature: [SDK Integration][Complex dependencies] Support for <not> operator in the dependency conditions.
• Feature: [SDK Integration] Migrated to https://github.com/NXP-mcuxpresso/mcux-sdk new site.
• Feature: [SDK Integration] Provide CLI utility to merge sub-manifest files: added the manifest.merge

command:
– Running the headless mode with -help manifest.merge generates a template property file, which contains

the following:
– manifest.xml (location of the manifest containing references to sub-manifests)
– repo.location (repository where the manifest specified in the manifest.xml property is located).
– merged.manifest.xml (location of the result manifest file).

– All properties from the template file must be specified for the command to run.
– The manifest specified in the manifest.xml file must be inside the repository specified.

• Improvement: [NPW][NHS3xxx] Added NHS3xxx support on the Preinstalled MCUs section.
• Improvement: [Flash Drivers] Various size optimizations for flash drivers binaries.
• Improvement: [SDK Integration] Right clicking the Installed SDKs pane provides a new option to link with the

"Download and Install SDKs" feature.
• Improvement: [Energy Measurement / Power Profile] Display the currently configured measurement range for

MCU-Link probes.
• Improvement: [SWO] Both trace clock and core clock are now exposed for the user, for devices that have a

TRACECLK different than the core clock (that is, Cortex-M7).
• Improvement: [IDE][Quickstart Panel] Added preferences to control activation and auto-selection inside

Project Explorer. Check these options on Preferences -> MCUXpresso IDE -> Quickstart Panel -> Project
Explorer activation and auto-selection of a project.

• Improvement: [IDE] Add watchpoint capability from the Peripheral (memory rendering) view.
• Improvement: [Power Profile] Add a new configuration tab for data gathering controlled by trigger in Power

Profile. Power Profile and Energy Measurement views now both have the UI that allows collecting data
based on a trigger; the two views do not share the configuration but they each hold their own user input. This
configuration UI is disabled if either Power profile or Energy Measurement is in play mode.

• Improvement: [Multicore] A post-build step in a multicore environment is now calling a new utility tool (called
mcux-fixelf) for multicore image processing purposes. The invoked command can be identified in Preferences
-> MCUXpresso IDE -> Default tool settings -> Multicore slave template. This step is intended for now to
replace the previous dd utility call plus some additional patches (like fixes for the forced relaxation of the
linker on exidx/extab sections, shifting on secondary core's sections performed when linking the full multicore
image).

• Fixed: [RTOS] Add preferences to control the persistence of RTOS TAD logs.
• Fixed: [Zephyr RTOS] When using J-Link and a Zephyr application built with CONFIG_INIT_STACKS=y, after

opening the Zephyr TAD View, the view defaults to not showing the stack high water marks.
• Fixed: [FreeRTOS] "Tasks" and "Heap Usage" views throw errors after resume.
• Fixed: [FreeRTOS] Timer List view displays a Java exception instead of a user-friendly error message.
• Fixed: [SWO] Silent error (in log) reported after using the SWO Data view and pressing the "Terminate"

button.
• Fixed: [SWO] Continuous refreshing in the SWO Config view when opening a debug session.
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• Fixed: [SWO] After terminating a debug session, if one of the SWO views is left running, an error message
continuously appears in the error log.

• Fixed: [SWO] The timeline in SWO Interrupts View may be inaccurate for Cortex-M7-based devices.
• Fixed: [SWO][Power Profile] Missing some of the available rates for PC sampling.
• Fixed: [SWO] SWO not properly closed/disposed when the view is closed. This spoils the data collected when

the view is reopened and a next SWO data collection session is started.
• Fixed: [SWO] "Unlock access" operation for CoreSight components configuration is missing from the "SWO

and Trace console" log.
• Fixed: [SWO] NPE thrown in error log when debug session starts with SWO Data view opened.
• Fixed: [Power Profile][SWO Profile] Wrong initial values displayed for profile sample rates (0.0 Hz).
• Fixed: [Energy Measurement] Previously used probe/debug context not displayed/kept after terminating

session.
• Fixed: [Energy Measurement] Voltage "Read from target" fails if analog source is selected first.
• Fixed: [Energy Measurement] IDE crashes when the Auto Scale button is pressed before doing any

configuration.
• Fixed: [Energy Measurement] Unable to interact with the view (zoom in/out, export data) after terminating a

running debug session while collecting analog data.
• Fixed: [Energy Measurement] Attaching to a debug session while data collection is in progress discards data

already collected.
• Fixed: [Energy Measurement] Canceling an import archive corrupts the already loaded plot.
• Fixed: [Energy Measurement] Wrong status message after changing to an out-of-debug probe while linked to

debug context.
• Fixed: [Energy Measurement] t_last (the last time for the x-axis of the graph) label displays incorrect values

when zooming in.
• Fixed: [Energy Measurement] Cannot re-export Energy Measurement data after import.
• Fixed: [Energy Measurement] "Horizontal Measurement" does not work properly.
• Fixed: [Install MCUXpresso SDKs] IDE filters now compatible SDKs versions. Note: The fix is working for IDE

versions no older than MCUXpresso IDE 11.5.0.
• Fixed: [SDK Integration] Unexpected "Memory type EEPROM for project 'null' is not supported" error message

displayed after a project is created.
• Fixed: [SDK Integration] On the "MCUXpresso IDE SDK uninstall" view, the buttons are no longer visible.
• Fixed: [SDK Integration] The component dependencies are not correctly solved in the case of switching cores

when creating a new (multicore) project.
• Fixed: [SDK Integration] The generated linker script file name shall follow the project name.
• Fixed: [SDK Integration] Cannot find J-Link debugger script referenced in SDK (for example, for RT1170

multicore projects).
• Fixed: [SDK Integration] Multiple SDKs are unexpectedly enabled/disabled if they share the same identifier

(so pointing to the same device target). Note: The behavior after this fix is that for older workspaces, all the
SDKs are enabled. Users have to disable (or uninstall) undesired SDKs manually.

• Fixed: [SDK Integration] Missing source paths when adding components within SDK Component Manager
view.

• Fixed: [SDK Integration][Ubuntu] Project names and descriptions are not displayed in the correct format on
certain boards.

• Fixed: [SDK Component Management] Changed the handling of the "Cancel" button during "Refreshing SDK
Components". If the user pressed "Cancel" to abort the comparison, the file was silently not replaced and the
update mechanism continued with the next file.

• Fixed: [NPW][SDK components selector] Board template cannot be deselected.
• Fixed: [NPW] Errors after creating a new project with the same name.
• Fixed: [Debugger][LPC541xx][PEmicro] Starting a multicore debug session, the secondary cores are not able

to execute application (wrong suspended state is shown instead).
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• Fixed: [Global Variables] The panning option in the graph is not enabled by default.
• Fixed: [Global Variables] View is not loading globals from ELFs specified in the Other Executables section of a

debug config.
• Fixed: [Linker scripts] Some projects could produce axf files which fail to program in GUI Flash Tool.
• Fixed: [Multicore] Unexpected data sections of the secondary core shifting in the final multicore application

image.
• Fixed: [Multicore] Command line build in headless mode fails for multicore projects.
• Fixed: [Project Manager] Missing header files in Project Explorer when using linked sources.
• Fixed: [IDE][Probes discovered] The "OK" and "Cancel" buttons change location after a while or after clicking

in different places.
• Fixed: [IDE] Creating "BareMetal" project fails and gives internal error.
• Fixed: [IDE] NPE for Heap & Stack view with using make file project.
• Fixed: [IDE] Different syntax coloring when project sources are copied vs linked.
• Fixed: [IDE][PEmicro] IDE freezes while doing flash erase after a plain load image error is encountered.
• Fixed: [Dark Theme] Project highlight in Project Explorer is white.

1.10  Version 11.6.1 (October 2022)
• Upgraded: Newer SEGGER J-Link software (v7.70d).
• Upgraded: Version v12.1 of MCUXpresso Config Tools.
• Improvement: [Flash drivers] Included K32W041AM flash driver in layout examples.
• Fixed: [SWO][RT1170] SWO trace timing is not accurate when the trace clock is different from the core clock

(for example, for Cortex-M7-based devices). This misbehavior is visible in SWO Interrupts view.
• Fixed: [SWO Counters] Cycle counter does not update while running and the Total value is wrong.
• Fixed: [NPW] Failed to create correct a project for K22FX512 and SDK 2.3.1.
• Fixed: [NPW] Cannot use New Project wizard with 2 SDKs for the same board.
• Fixed: [NPW] SDK_DEBUGCONSOLE_UART option (which redirects the standard printf to UART) ignored

when importing SDK examples.
• Fixed: [SDK Integration] Error thrown at build on FRDM-KL0Z from Import SDK example.
• Fixed: [Flash drivers] In provided /ide/Examples/Flashdrivers/NXP /iMXRT/iMXRT117x_FlexSPI_SFDP.zip,

the octal flash RST control pin must be 0xOD (1.8 V) instead 0x0A (3.3 V).
• Fixed: [Project Manager] Missing Floating Point options for Cortex-M33 architecture.

1.11  Version 11.6.0 (July 2022)
• Upgraded: Newer SEGGER J-Link software (v7.66e).
• Upgraded: Newer PEmicro plugin (v5.2.6).
• Upgraded: Newer xPack Windows Build Tools (v4.3.0-1).
• Upgraded: Update for Ubuntu 22.04 LTS.
• Upgraded: Eclipse version to 2021.12 (Eclipse Platform 4.22.0 / CDT 10.5.0).
• Upgraded: GNU ARM Embedded Toolchain to version 10.3-2021.10.
• Upgraded: Version v12 of MCUXpresso Config Tools.
• Added: [NPI] IMXRT1040 support.
• Feature: [Power Profile] Added Power Profile feature aiming to correlate energy/power measurement with

SWO trace.
• Feature: [Energy Measurement][Power Profile] Add analog data traffic statistics information for energy/power-

based views.
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• Feature: [Zephyr RTOS] Added GDB thread awareness for LinkServer debug connection and Threads view
support.

• Feature: [SDK Integration] Support to allow sub-manifest under the same SDK.
– Adapted SDK Creator for creating split manifest.
– Update "Contribute project to SDK Git repository" feature to work with the new sub-manifests.

• Improvement: [IDE] Ability to control enablement of map/linker parser. Added three options in Preferences ->
MCUXpresso IDE -> Editor Awareness, which allow users to enable or disable the map parser, the GNU linker
parser, and the Linker Script template parser. IDE needs a restart for the changes to take effect. This change
only works when starting the IDE in clean mode (for example, adding -clean in the .ini file).

• Improvement: [SDK Integration] Display multiple suggested remote GitHub NXP repos.
• Improvement: [SDK Integration] Create a unique name for an SDK Git Repository.
• Improvement: [SDK Integration] Make all project components optional. In this way, the user may select any

component that goes in the generated project so "minimal project" can be achieved.
• Improvement: [SDK Integration] Highlight unsatisfied dependency on core-specific component.
• Improvement: [Energy Measurement] Mark the non-plotable area (suspended or trigger-off) as not available -

no plots or lines.
• Improvement: [Peripherals+] Highlight the field(s) that changed when the register has changed.
• Improvement: [IDE] strip and symdefs command missing in Preferences -> MCUXpresso IDE -> Utilities.
• Fixed: [IDE] "Save As" Perspective makes Restart toolbar group disappear.
• Fixed: [IDE] IDE freezes for too long if opening the Global Variables View.
• Fixed: [IDE] Blue debug icon only enabled if QuickStart View is present.
• Fixed: [IDE] Trying to use QuickStart View debug buttons can easily trigger flash erase when the QuickStart

View window is smaller.
• Fixed: [Debugger][LinkServer] Restart of a suspended FreeRTOS application fails on LPC55S16.
• Fixed: [Debugger][LinkServer] Suspend timeout in "all-stop" mode while stepping over assembly loop.
• Fixed: [Debugger][LinkServer][macOS] Support for simultaneous debug sessions is broken.
• Fixed: [Debugger] "GDB crash - internal-error: virtual memory exhausted" debugger reported error. This issue

was indirectly fixed by:
– Fix FreeRTOS SP offset (LinkServer GDB thread awareness reported an incorrect value for the SP register

with FreeRTOS applications);
– Document the LR stack unwind issue on FreeRTOS.

• Fixed: [Debugger][LinkServer][RT1170] When RT1170 is configured to use CM4 as primary (booting) core,
flashing application fails if the default VECTREST is used as flash driver reset handling.

• Fixed: [Debugger][LinkServer] Sometimes the semihost console does not completely print or is empty.
• Fixed: [Peripherals+][RT1170] CCM registers incorrect base addresses for GPR and OSCPLLx registers.
• Fixed: [SWO][Debug console] [LPC812] Wrong ROM base table address.
• Fixed: [SWO][ITM Console] If the "Clear console" button is used, a lot of items are then lost.
• Fixed: [SWO][ITM Console] Output is slow and duplicated on LinkServer.
• Fixed: [Image Info] Callgraph fails to display information for linked folders.
• Fixed: [Dark theme] Some table entries in "Heap and Stack Usage" view display light theme colors.
• Fixed: [FreeRTOS] Failed to populate TaskList View in FreeRTOS when the backward compatibility flag is set.
• Fixed: [Flash Programmer] Flash driver "ChecksumSectors" error Ef(38) using LPC845-BRK board.
• Fixed: [SDK Integration] Import project wizard option "Use floating point version of printf" does not properly set

preprocessor macros.
• Fixed: [SDK Integration] Incorrect FPU settings in threadx_lib project.
• Fixed: [SDK Integration][GitHub] A project created from an exported C library project does not build.
• Fixed: [SDK Integration][SDK 2.11] In certain situations, adding components to a project results in missing

header file compile errors.
• Fixed: [Global Variables] Wrong values (sometimes negative ones) appear on the Oy axis of the plot.
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• Fixed: [Energy Measurement] Sometimes, canceling the measurement export does not work.
• Fixed: [Energy Measurement] Negative values on t0 label for Ox axis might be encountered after board

configuration.
• Fixed: [Energy Measurement] Channel switch (power -> current) shows wrong scale values.

1.12  Version 11.5.1 (April 2022)
• Upgraded: CDT from CDT 10.3.0 to CDT 10.3.3. This upgrade is intended to address: https://bugs.eclipse.

org/bugs/show_bug.cgi?id=575903 issue.
• Upgraded: Newer SEGGER J-Link software (v7.62c).
• Upgraded: Newer PEmicro plugin (v5.2.0).
• Added: [NPI] RT1060X (RT1060 phantom) support.
• Feature: [Flash Programmer][RT1160/RT117x] Add flash driver for QSPI on FlexSPI2 Port A.
• Fixed: [Debugger] Notifications about new MCU-Link firmware releases are sometimes not shown in the

Probes Discovery dialog.
• Fixed: [Debugger] Debug operations are slow while the Peripherals+ window is open on targets with lots of

registers (like RT1160 or RT117x).
• Fixed: [Project Manager][RT1160/RT117x] Flood of the -D__MULTICORE_MASTER in the .cproject.
• Fixed: [Project Manager][RT1160/RT117x] M7 C++ project failed to load the M4 project (in the case of

multicore configuration) on a particular application. Now, exdata sections are placed before heap and stack
sections in generated linker files (when using Managed Linker Script configuration). In the previous version,
the exdata sections were placed before the data sections.

• Fixed: [Peripherals+][LPC546xx] EMC register location/offset is incorrect in the Peripherals+ window.
• Fixed: [Energy Measurement] Instability if Energy Measurement view is used together with SWO Profile.

1.13  Version 11.5.0 (January 2022)
• Upgraded: Eclipse version to 2021.06 (Eclipse Platform 4.20.0 / CDT 10.3.0).
• Upgraded: MCUXpresso IDE integrated with OpenJDK11 (HotSpot engine build 11.0.11+9).
• Upgraded: GNU ARM Embedded Toolchain to version 10.3-2021.07.
• Upgraded: Version v11 of MCUXpresso Config Tools.
• Upgraded: Windows 11 and macOS 12.0.1 (Monterey) support.
• Upgraded: Newer SEGGER J-Link software (v7.60b, 64-bit version).
• Upgraded: Newer PEmicro plugin (v5.1.6).
• Synchronization with SDK v2.11.x and manifest schema version 3.9.
• Synchronization with FreeRTOS 10.4.3.
• Added: LPC55S36 support.
• Added: PN7640 support.
• Added: IMXRT685-AUD-EVK support.
• Feature: [FreeRTOS] Added Task Notifications view. Separate FreeRTOS view was added to display the task

notification list for each task, including status and value properties.
• Feature: [SDK Integration] Integration with GitHub SDK repository:

– Support for installing a remote SDK GitHub repository
– Support for installing an already cloned repository
– Ability to contribute a project back to SDK GitHub repository
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• Feature: [SVD] The user can specify a custom SVD file location inside a project. The file can be added from
Project Properties -> Run/Debug Settings -> MCU Settings -> SVD Selection. The Peripherals+ view uses this
file when debugging that project.

• Feature: [Energy Measurement] Extensions and improvements:
– Data gathering enabled/disabled by trigger signal MCU-Link Pro and on-board probes with energy

measurement circuitry can use a GPIO signal as a trigger/enable (input) for the energy measurement. Note:
This feature requires firmware version MCU-LINK CMSIS-DAP v2.249 (or greater).

– Increase the maximum analog data collection time limit from 5 minutes previously to unlimited time,
depending on the available space on disk. Note. Exported energy measurement session from an older
MCUXpresso version is not compatible within MCUXpresso v11.5.0 version.

– Improve the performance of retrieving measurement data from the probe. This improvement minimizes the
chance of experiencing lost data packets which, in earlier versions, sometimes manifested as gaps (of a few
ms in length) in the data plot when sampling at high data rates. Even in the unlikely circumstances of still
missing some measurement data packets, the IDE can now supplement the missing data by reconstructing
it from a lower resolution version of the same data (averaged at probe level) to correct the energy/power
calculation. When this situation arises, the corresponding range on the plot is drawn as a compact area (due
to lacking variation between samples normally present in the high-resolution measurement data).

• Feature: [SWO] Target configuration is now optional within SWO functionality. Depending on debug probe
type, the user may choose not to automatically configure the target inside the "SWO Trace Config" view.
Using this option, the user can then make their own registers configuration within the application.

• Feature: [SWO] A new console named "SWO and Trace Console" displays all configuration and register
settings performed while configuring SWO.

• Feature: [Debugger][J-Link] Auto-debug secondary projects for multicore is now added for J-Link debug
session too (now all debug connection types are offering this support). Option is set by default on: Window
-> Preferences -> MCUXpresso IDE -> Debug Options -> J-Link Options -> Enable Auto-debug secondary
project(s) for multicore projects.

• Feature: [Flash Programmer][RT1170] Add flash driver for the (non-default) Octal flash device on the EVK
board.

• Feature: [IDE] The IDE does not internally use the WMI command-line utility anymore (deprecated as of
Windows 10, version 21H1). PowerShell is used instead.

• Fixed: [Project Manager] "Remove path from __FILE__" option not working for projects with linked sources
(not copied into workspace).

• Fixed: [Project Manager] Project-relative connect and reset scripts do not work.
• Fixed: [Project Manager][LPC55S69] Changing RAM size from project properties results in build errors.
• Fixed: [Project Manager] "Restart" or "Terminate and Relaunch" are not enabled for custom-made PEmicro

launches.
• Fixed: [Energy Measurement] Unable to export data after terminating current analysis and cleaning up debug

processes.
• Fixed: [Energy Measurement] Canceling an import data operation is not working.
• Fixed: [Energy Measurement] Can't start a new measurement session if there is a measurement connection

left active in another IDE instance.
• Fixed: [Debugger] Terminate button throws an exception after the debug session using LinkServer.
• Fixed: [Debugger][CM33] `cmbreakset` doesn't work from the redlinkserv console.
• Fixed: [Debugger][RT1160/RT1170] CPU doesn't halt on faults.
• Fixed: [Debugger][RT1160/RT1170] CM4 example does not reach main.
• Fixed: [Debugger][J-Link] Restart not working when debugging an application executing from SRAM

(debugger not initializing program counter and stack pointer).
• Fixed: [Debugger][LinkServer] Debug connection uses excessive host CPU power.
• Fixed: [Debugger][LinkServer] SWD/JTAG pins are now disabled after terminating a LinkServer debug

session.
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• Fixed: [Debugger][LinkServer] Launch configurations referring absolute paths of ELF files are considered
invalid.

• Fixed: [SDK Integration] Unable to select UART with single click when using the "Import SDK example(s)"
wizard.

• Fixed: [SDK Integration] [RT1170] Project building fails after adding SSARC driver.
• Fixed: [SDK Integration] Synchronize Semihost/UART option check with library type (semihost/nohost)

selection. Note: This behavior applies to both GUI and CLI. Even if the example description specifies a default
IO library type, the IDE overwrites this option if the chosen IO model is incompatible with it.

• Fixed: [SDK Integration] Build fails after removing SDK components that have additional libraries.
• Fixed: [Azure RTOS ThreadX] Threads view shows odd values for stack usage on all threads.
• Fixed: [SWO] Profiling counters view displays some wrong values.
• Fixed: [SWO] Profiling counters are created and accessed even when SWO not configured or available,

causing memory access errors.
• Fixed: [SWO] Statistics (from SWO Trace Config view) indicates wrong information.
• Fixed: [SWO] IDE freezes for a period when detecting/setting the SWO clock.
• Fixed: [SWO] ITM console does not work.
• Fixed: [Quick start panel] Copy-paste and multiple selection do not work for project properties.
• Fixed: [Peripherals+] Most of PWM registers are not shown.
• Fixed: [Dark Theme] Some of the view names inside SWO Views are not readable.
• Fixed: [IDE] Sometimes, ConcurrentModificationException exception message is seen when starting

MCUXpressoIDE 11.4.1.
• Improvement: [IDE] Auto-resize columns from Probes Discovered dialog to accommodate the length of

displayed strings.
• Improvement: [IDE] The memory configuration editor dialog is now resizable.
• Fixed: [ImageInfo] Various features indicate files/information from the wrong project in the case of multiple

projects having similar names within the workspace.
• Fixed: [ImageInfo] CallGraph indicates a wrong (negative) stack usage value for the "Exception Handlers"

virtual node. This field should be empty for virtual (nonexistent) nodes.
• Fixed: [Global Variables] Sometimes the decimal number format displays empty values in the view.
• Fixed: [Installer][macOS] Reinstalling the same MCUXIDE build version results in errors when launching the

product.
• Fixed: [Installer] Uninstall sometimes fails when processes associated with the current installation are open.

1.14  Version 11.4.1 (September 2021)
• Upgraded: Newer SEGGER J-Link software (v7.54b, 32-bit version on Windows, 64-bit version on Linux/

macOS).
• Upgraded: Newer PEmicro plugin (v5.1.0).
• Added: MCU-Link Pro probe support.
• Improvement: [SWO/Energy Measurement] Improved data collection rate. This aims to decrease the rate of

lost packets (SWO) and gaps (Energy Measurement) at higher speed rates.
• Improvement: [LPC55xx] Add support in LinkServer flash drivers for programming data to the last flash sector

(up to and excluding the reserved region).
• Fixed: [SWO] NPE obtained in the case of some SWO error types. This prevents the error dialogs from

appearing (the exceptions go silently).
• Fixed: [Energy Measurement] Detect data stream corruption and gracefully terminate Energy Measurement or

SWO data retrieval if this situation arises.
• Fixed: [Energy Measurement] Sometimes stale data remains after clearing the data.
• Fixed: [Energy Measurement] No energy consumption info is displayed when measuring high (> 1W) power.
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• Fixed: [Energy Measurement] No data is displayed after a while when measuring high currents.
• Fixed: [FreeRTOS TAD] Heap5 data not shown in Heap Usage view.
• Fixed: [Azure RTOS TAD] Azure RTOS debug session closes unexpectedly when using non-CM7 devices.

1.15  Version 11.4.0 (July 2021)
• Upgraded: Eclipse version to 2020.12 (Eclipse Platform 4.18.0 / CDT 10.1.0).
• Upgraded: IDE now integrates with OpenJDK11 (HotSpot engine, v11.0.10).
• Upgraded: GNU ARM Embedded Toolchain to 10-2020-q4-major. Note: on top of GNU ARM Embedded

Toolchain 10-2020-q4-major, gcclib was recompiled using the bug fix from https://gcc.gnu.org/bugzilla/show_
bug.cgi?id=99157. This patch prevents run-time application corruption when using -mcmse support (applied
for armv8m only).

• Upgraded: Version v10 of MCUXpresso Config Tools.
• Upgraded: Newer SEGGER J-Link software (v7.50, 32-bit version on Windows, 64-bit version on Linux/

macOS). V7.50 comes with a 64-bit version of Windows. This 64-bit version is compatible and can be used
if desired, but note that the MCUXpresso IDE 11.4.0 installation does not include this and only partial testing
has been possible due to the timing of the release. If you prefer to use the 64-bit version on Windows:
– Install 64-bit Windows SEGGER J-Link software
– Go to IDE -> Preferences -> MCUXpresso IDE -> Debug Options -> J-Link Options -> J-Link Server

executable and change it from the existing path to the 64-bit version installation path, that is, for the default
installation path: C:Program FilesSEGGERJLinkJLinkGDBServerCL.exe

• Upgraded: Newer PEmicro plugin (v5.0.4).
• Upgraded: FreeRTOS TAD synchronization with FreeRTOS v10.4.3.
• Added: MKE1xZ support.
• Feature: [Azure RTOS ThreadX] Added GDB thread awareness. The user is able to see threads in Debug

view (only when using all-stop debug mode, similar to FreeRTOS usage) and also the register context
associated with the currently selected thread.

• Feature: [Azure RTOS ThreadX] Added views, similar to the FreeRTOS, for Thread list, Message queues,
Semaphores, Mutexes, Event flags, Timers, Memory block pools, and Memory byte pools. These views are
available under a new menu group called "RTOS", where older FreeRTOS views can be also found.

• Feature: [Azure RTOS ThreadX] Added the ability to export trace data generated by the application at run-
time. Decoding of exported data is done using Microsoft's Azure RTOS TraceX host-based analysis tool.
Detailed procedure is described in the Azure RTOS User Guide.

• Feature: [Energy Measurement] Add measurement/plot capability for MCU-Link probe. Power measurement
can be done using:
– The new MCU-Link double channel measurement capability (current and voltage measured

simultaneously);
– Existing capability (used over LPC-Link2 probes) of caching voltage measurement to use on power

computation over current measurement.
• Feature: [Offline Peripherals] Added offline peripheral view. With this view, the peripheral registers can be

inspected out of a debug session. A device selector or the current project selection can be used to load
register information for a particular device. Additionally, an SVD file can be imported.

• Feature: [Debugger][MCU-Link] Differentiate MCU-Link product names used when MCU-Link probes
enumerate on USB. Example:
– base model: MCU-LINK (r0FF) CMSIS-DAP V2.219
– Pro model: MCU-LINK Pro (r0C7) CMSIS-DAP V2.219
– on-board: MCU-LINK on-board (r0CF) CMSIS-DAP V2.219

• Feature: [Debugger][J-Link] Added possibility to connect to a remote gdb server. In launch configuration -> J-
Link Debugger tab -> GDB Server Settings, use Server execution option to set a remote server.
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• Improvement: [Debugger][J-Link] Add nickname for JLink probes in Probes Discovered Dialog and in JLink
Debugger tab.

• Improvement: [Debugger][PEmicro] Added nickname for PEmicro probes in Probes Discovered Dialog.
• Feature: [SDK Integration] UART console is the default debug console when importing a project.
• Feature: [Flash Programmer] External flash drivers for RT500 and RT600 available as examples in <install_

dir>/ide/Examples/Flashdrivers/NXP/iMXRT.
• Improvement: [Peripherals+] Peripherals+ view design was changed to support register group expansion

directly into the Peripherals+ view, with no extra Memory View usage. Consequently, all elements shown
before in Memory View are now available directly in the Peripherals+ view: values, bitfields, and details. Reset
value can be inspected as well together with the rest of the register elements.

• Improvement: [IDE] Added a link to MCU-Link firmware page in 'Additional resources' menu entry under
Help's main menu.

• Improvement: [IDE] Toolbar naming and grouping: some icons re-grouped to reflect better categories and
functionalities.

• Improvement: [SWO] Adapt SWO trace config error to better reflect possible causes.
• Improvement: [Flash Programmer] Use probe serial instead of probe index when generating command line.
• Fixed: [Flash Programmer][Command Prompt] Wrong usage of double quotes in GUI Flash Tool Command

Line generates errors in command prompt execution.
• Fixed: [Flash Programmer][Segger][Command Prompt - Windows] GUI Flash Tool preview command - lower

pane script not working when project name contains spaces.
• Fixed: [Flash Programmer] Cannot program flash from Quickstart Panel if "preview command" is checked in

launch config.
• Fixed: [Flash Programmer] Wrong usage of double quotes in GUI Flash Tool Command Line.
• Fixed: [Debugger] Modifying from debugger 8-bit or 16-bit data residing at addresses not aligned to 32 bits

may alter data beyond the intended range up to the next 32-bit address.
• Fixed: [Debugger] Cannot relaunch (using "Terminate and Relaunch") a running session.
• Fixed: [Debugger] Suspend "bubble" project crashes debugger connection on LinkServer when using Non-

Stop mode.
• Fixed: [Debugger] Debugger sets two breakpoins at the same address when debugging with J-Link. This

generates a warning when trying to restart the debug session.
• Fixed: [Debugger] Always meet "Not Responding" issue when clicking the debug button without build first (for

larger projects).
• Fixed: [Debugger] J-link debug button does nothing when load image is set.
• Fixed: [Debugger] hello_world does not read the input from the console.
• Fixed: [Debugger] "Interrupt failed" pop-up error window during debug with FRDM-K64F and LPC-Link2 for

some projects.
• Fixed: [Debugger] First attempt to manually modify the PC register is ignored.
• Fixed: [Debugger] Exceptions occurring while closing a project with an active debug session
• Fixed: [Debugger] Restart not working in attach mode
• Fixed: [Debugger][88MW320] Attach to a running target with PEmicro on FreeRTOS projects starts with faults.
• Fixed: [Debugger][88MW320] Cannot debug twice with J-Link and PEmicro.
• Fixed: [Debugger][FreeRTOS] Heap and Stack Usage View shall work with FreeRTOS-enabled projects.
• Fixed: [Debugger] Multiple J-Link instances (named as "3rd party CMSIS-DAP") appear in Probes Discovered

view: now these are filtered out. If a user still wants to see them, check the option from Preferences -> Debug
Options -> J-Link Options -> Enable discovering of "3rd party CMSIS-DAP" probes.

• Fixed: [Debugger][J-Link] Primary core in multicore context is attached (instead of a regular debug session) to
target after debugging.
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• Fixed: [Debugger][LinkServer] Modifying from debugger 8-bit or 16-bit data residing at addresses not aligned
to 32 bits may alter data beyond the intended range up to the next 32-bit address.

• Fixed: [Debugger][iMX RT595] Unable to flash application using crt_emu_cm_redlink raw command:
– Added preconnectscript argument to stub
– Added --preconnectscript in the IDE's flash tool preview command window bottom
– Note: Preconnect scripts have been changed to use variable a% instead of p% to receive the probe index.

The user might need to update custom preconnect scripts.
• Fixed: [Energy Measurement] Format Y axis using a scale suitable for all displayed values (when having large

Oy scale to represent data).
• Fixed: [Energy measurement] Unable to exit probe discovery for boards with unsupported firmware for SWO.
• Fixed: [Energy Measurement] The Energy measurement cannot collect if associated with a debug session

and SWO is not initialized.
• Fixed: [Energy Measurement] Making a selection on the plot may lose part of the status line.
• Fixed: [Energy Measurement] Negative zero (-0.00) values shown.
• Fixed: [Energy Measurement] Lot of remaining allocated heap after clearing a plot.
• Fixed: [Energy Measurement] Incorrect representation of individual samples when the probe has been booted

for some time: there are multiple values represented at the same point in time.
• Fixed: [Energy Measurement] Table containing analog sources not empty after terminating analysis session.
• Fixed: [Energy Measurement] When a view is already connected to a board and the underlying board is

changed (without using the Terminate button), a subsequent operation causes an error dialog with two entries
and no useful information. View becomes unusable after this point.

• Fixed: [Energy Measurement] Export contains much more data than intended.
• Fixed: [Energy Measurement] Power/energy info in status line does not follow the currently visible part of the

measurement.
• Fixed: [Energy Measurement] IDE now reports an error in the case the connection was interrupted while

collecting power measurement data.
• Fixed: [Energy Measurement] Wrong resistor values displayed for QN9090 measurement circuit.
• Fixed: [Energy Measurement] Fixed 'None' in Tooltip for Cursor options in the Energy Measurement toolbar.
• Fixed: [Energy Measurement] Export contains more data than intended (from previous measurements).
• Fixed: [Energy Measurement] Old recorded values displayed on the graph. This makes the starting graph

contain unexpected data.
• Fixed: [Energy Measurement] Reading from a target never finishes in some situations.
• Fixed: [Energy Measurement] Not all plotted values are using the same scale. This behavior results in some

values being displayed with wrong values.
• Fixed: [SWO][RT1010/RT1170/RT1160] Fixed SWO support.
• Fixed: [SWO] Detecting clock feature is not overwriting the value. This behavior is inducing some errors in

enabling SWO features.
• Fixed: [SWO] Misleading error message when trying to enable SWO on secondary cores.
• Fixed: [FreeRTOS] Sometimes you cannot suspend FreeRTOS application using LinkServer.
• Fixed: [FreeRTOS] Modifying a register causes it to be set to 0.
• Fixed: [FreeRTOS] Attach to a FreeRTOS application returns faults.
• Fixed: [FreeRTOS] Empty tooltip for "Runtime" column from Tasks list view.
• Fixed: [FreeRTOS] Queue items incorrectly decoded in the Queues list view.
• Fixed: [FreeRTOS] No FreeRTOS queue data details are shown.
• Fixed: [FreeRTOS] LinkServer FreeRTOS awareness does not activate for secure projects.
• Fixed: [FreeRTOS] GDB shuts down when restarting RTOS debug session while stopped at BP.
• Fixed: [SDK Integration] The 'Open SDK handling preference page' button opens an unexpected option from

Preferences.
• Fixed: [SDK Integration] SDK component replacement options are ignored.
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• Fixed: [SDK Integration] It is not possible to disable the "--sort-section=alignment" linker option from SDK
generators.

• Fixed: [SDK Integration][SDK Details Page] Various NPE when using the details in Outline view.
• Fixed: [SDK Importer] Sometimes, board memory ranges are missing when importing an example project.
• Fixed: [SDK Importer] MCUXIDE mixes files from different versions of packages while importing examples.
• Fixed: [SDK Importer] All SDKs are present after clicking the outside of SDKs image areas.
• Fixed: [SDK Importer] The linked example from Board SDK Wizard is not visible in the Import SDK example

Wizard.
• Fixed: [SDK Importer] Selected SDK, in the case of multiple SDKs using the same device, is not honored

when importing or creating an example project.
• Fixed: [SDK Importer] SDK Import Wizard gives the wrong selection after it is opened and choose expand

arrow.
• Fixed: [SDK Importer] CMSIS component with "type: CMSIS" is ignored when importing SDK project.
• Fixed: [SDK Importer] Boards vs device filter does not work when clicking the "Available boards" section

outside the board picture areas.
• Fixed: [SDK Importer] Non-multicore projects of boards with multicore support have the primary decorator

when created.
• Fixed: [SDK Importer] doc folder is declared as a source folder in versions 2.9.x of the RT SDK.
• Fixed: [SDK Importer] Cannot import multiple projects - importAll fails with OutOfMemory error.
• Fixed: [SDK Importer] SDK cannot set default launch config options for J-Link.
• Fixed: [SDK Importer] Fail to use an SDK with "/" included in the family name.
• Fixed: [SDK Importer] Project-specific linker file is ignored for MCUXIDE.
• Fixed: [SDK Importer] Default components are now displayed for a device project.
• Fixed: [SDK Importer] "Select SDKs for selected MCU" widget is not correctly populated when 2 SDKs are

installed for the same device.
• Fixed: [SDK CLI] project.build command exits with a null pointer exception when use.all.components is set on

true.
• Fixed: [SDK CLI] Example.build command not working on multicore projects.
• Fixed: [SDK CLI] Command line generates a project name with not-allowed characters ("(", ")").
• Fixed: [SDK CLI] Null PointerException when using the sdk.validate command.
• Fixed: [SDK CLI] Null pointer exception obtained when using -help argument.
• Fixed: [NPW] Creating a project using "Makefile Project using Existing Code" template, fails at debugging with

LinkServer.
• Fixed: [NPW] Device project template is not correctly referred when using NPW to create a project with

"selected device without board".
• Fixed: [NPW] Unable to create a project for the second board when 2 SDKs for the same device are installed.
• Fixed: [Image Info] missing functions from CallGraph building in release build configuration.
• Fixed: [Image Info] Callgraph does not display stack info for c symbols located within cpp sources.
• Fixed: [IDE] Key binding conflict reported with new workspace.
• Fixed: [IDE] Tooltips missing for PEmicro Debugger Launch Configuration Startup Tab.
• Fixed: [Dark theme] Usage in Heap and Stack Usage view.
• Fixed: [Dark Theme] pop-up hover not readable for longer preference text.
• Fixed: [Dark Theme] Selection is not visible in the Installed SDKs list.
• Fixed: [Dark Theme] MCUXpresso Icon in Smart Import Wizard shows white corners.
• Fixed: [Installer] Uninstaller error in the case of uninstall with a started Eclipse session.

1.16  Version 11.3.1 (March 2021)
• Upgraded: Newer SEGGER J-Link software (v6.98a).
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• Upgraded: Newer PEmicro plugin (v4.9.0).
• Added: 88MW320 support.
• Added: K32W041A support.
• Added: i.MX RT1160 support.
• Feature: Added MCU-Link firmware version check in MCUXpresso IDE:

– When connecting to target, "Probes discovered" indicates if there are debugger probes that would require
update

– Each discovered probe clearly indicates (by a warning icon) if a firmware update is available
– Tooltip on the mentioned probes indicates the download location and the version of the firmware.

• Fixed: [RT1170] Can't download image to RT1170-EVK when SRAM_ITC_cm7 is located as the first item in
RAM blocks in Memory configuration editor.

• Fixed: [RT1170][CM4 boot] Error programming flash in SDP or empty flash situations.
• Fixed: [RT5xx/RT6xx] wrong image type (at offset 0x24) in generated executable file.
• Fixed: [KW38] Instruction Trace window does not pull the assembler instructions.
• Fixed: [K32W041AM] SWO Trace not working.
• Fixed: SDK cannot set default launch config options for Segger.
• Fixed: Exception if the IDE is launched right after installation process, having all checkboxes for additional

documentation selected.
• Fixed: Welcome page not appearing at startup.
• Fixed: Program and Erase Flash shortcuts from Quickstart Panel are also launching an unexpected debug

session at the end of their normal operation.
• Fixed: LinkServer: Modifying from debugger 8-bit or 16-bit data residing at addresses not aligned to 32 bits

may alter data beyond the intended range up to the next 32-bit address.

1.17  Version 11.3.0 (January 2021)
• Upgraded: Version v9 of MCUXpresso Config Tools.
• Upgraded: Newer SEGGER J-Link software (v6.88c).
• Upgraded: Newer PEmicro plugin (v4.8.5).
• Upgraded: Eclipse version to 2020.06 (Eclipse Platform 4.16.0 / CDT9.11.1).
• Upgraded: IDE now integrates with OpenJDK8.
• Upgraded: GNU ARM Embedded Toolchain to GCC9-2020-q2-update.
• Integrated: GNU test coverage (gcov) and performance analysis (gprof) tools and Eclipse plugins.
• Added: i.MX RT1170 B0 support.
• Added: i.MX RT1024 support.
• Added: RT500 B2 support.
• Added: K32W061 support.
• Added: K32W041AM support.
• Added: LPC55S06 support.
• Added: MCU-Link probe debug support.
• Feature: Added Energy Measurement view aiming to replace the Power Measurement view. Main capabilities:

– The new view comes with the same feature set as the old Power Measurement view.
– From a GUI perspective, it offers consistent look & feel with other views that display and controls graphs (for

example, Global Variables, and SWO-related views).
– Compatible with existing LPCXpresso boards having on-board power measurement circuits
– Power and energy estimation capability: In order to enable power/energy measurement/estimation the user

should add a reference voltage in the Config tab section from Energy Measurement view. For convenience
and more precise measurement, the user can press "Read from target" which automatically generates a
reference voltage computed as an average value (of the voltage) measured for the last 500 msec. Energy
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and power are displayed in the status line of the plot area, showing the min/max/average power values and
the energy value for the measurements visible in the graph, or over a particular time range selection.

– Multiprobe and multiview support: the feature is capable of opening multiple views, each view can be
connected to a different probe (that is capable to measure analog). The probe can be selected from Probe
Discovery feature available in the Energy Measurement view toolbar.

– Data collecting during an out-of-debug session and also during an active debug session
– Data collecting with an active debug session while the core is in debug mode. Behavior is controlled via

toolbar buttons
– Configuration of the server-side (rltool) and of the IDE using the Config tab within the view
– Import/Export data functionality for offline analysis: (buttons on the Energy view toolbar). The user is able to

save (Export data, in a zip format) the data collected within the view, having the possibility to load the saved
data (Import data) later, in the same view or another one. Loading saved data in the Energy Measurement
does not require physical connection to the target.

– Extended LPC-Link2 support for all targets having onboard measurement circuit:
LPCXpresso546x8/540xx/54S0xx, LPCXpresso54102, LPCXpresso51U68/54114, QN90x0/JN518x/
K32W0x1. As a side note, if there is any other LPC-Link2 board having power measurement capability, the
user can use an existing configuration (and change the resistor value if necessary).

– See MCUXpresso_IDE_Energy_Measurement.pdf (or Help -> Help Contents) for details.
• Feature: Auto-debug secodary project(s) for multicore projects option becomes the default option for multicore

debug purposes (for LinkServer debug connection only). That means, in the case of multicore projects on
which primary project refers one or several secondary projects, debug sessions are automatically started
for secondary projects after initiating debug with the primary project. Option is set by default on: Window -
> Preferences -> MCUXpresso IDE -> Debug Options -> LinkServer Options -> Miscellaneous -> Enable
Auto-debug secondary project(s) for multicore projects. If you don't want to have this feature enabled (so if
you want to start debug sessions for each core independently), uncheck this option. Similarly, Auto-debug
secondary project(s) for multicore projects option becomes default option for multicore debug purposes for
PEmicro too. Option is set by default on: Window -> Preferences -> MCUXpresso IDE -> Debug Options ->
PEMicro Options -> Enable Auto-debug secondary project(s) for multicore projects.

• Improvement: Enhance SWO views:
– SWO Config: added new Tab for data traffic statistics, configuration for ITM Stimulus ports
– SWO Profile: added samples and details tabs
– SWO Data: added plot (similar to Global Variables)
– SWO Stats: moved inside SWO Config
– ITM Console: added one tab for each stimulus port

• Improvement: [RT600] Clean up on RT600 flash drivers:
– Add drivers for MXIC_OPI connected via FlexSPI_A port
– Add drivers for QSPI drivers (SFDP) connected via FlexSPI_B port
– Add drivers for QSPI drivers (SFDP) connected via FlexSPI_A port
– Remove MIMXRT600_SFDP_* drivers generated by the old project (SDK now references the new drivers).

• Improvement: Drop-down boxes from several tables require two user operations to reach the actual items
from the list. Reduced now to a single operation (single click).

• Improvement: Extend CLI functionality - Add new command to list SDK info: -filter=<string>: filters the
available information based on regex expression string. For example, -filter=K64 displays all data containing
K64 string. See SDK command line documentation within the layout (MCUXpresso_SDK_Command_Line_
User_Guide.pdf).

• Improvement: Added Instruction Trace support for LPC55S69.
• Improvement: Merge c_include path section into cpp_include path section for cpp project in project settings.
• Improvement: New project wizard is now capable of handling HW with dual primary/secondary roles (that

is, RT1170). From SDK Wizard page, any core can be selected according to the primary/secondary SDK
description, plus it can be selected as standalone (application).
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• Improvement: Community forum accessible now from the main toolbar too (together with the older link from
Help->MCUXpresso IDE support forum). The default selection opens the community web inside the IDE. If
you want to set the default browser as external browser, use Window->Preferences->General->Web browser -
>"Use external web browser".

• Fixed: [RT500] QSPI flash drivers: driver was incorrectly using QSPI DDR instead of SDR.
• Fixed: [RT500][RT600] J-Link launch config default resets:

– Re-enable resets in J-Link launches for RT500/RT600
– The most recent J-Link versions properly handle resets for RT500 & RT600 devices.

• Fixed: [RT500] Unable to Restart flash-based session on EVK RevC1 board.
• Fixed: [RT685] "Unsupported or unrecognized format error" dialog when using the installed SDK.
• Fixed: [LPC55S69] Implemented DWT (Data Watchpoint and Trace) component for ArmV8. This fixes the

SWO Data trace not working issue.
• Fixed: [LPC55S06] SWO support.
• Fixed: [LPC55xx] LinkServer debug cannot recover LPC55xx from deep sleep.
• Fixed: [LPC845] Debug fails when SRAM is split into sub-blocks.
• Fixed: [LPC4337] Flash programming over JTAG not working on the M4 core.
• Fixed: [LPC54114] SWO Trace is not working with PEmicro.
• Fixed: [FRDM-K64] Removed unexpected warning reported in map file in a project.
• Fixed: [JN5189/QN9090/KW32W041AM] Improve OOB experience with (factory) erased devices.
• Fixed: IDE 'Utility' menu does not work for linked Folders.
• Fixed: Defined symbols are added prematurely (even when no component is selected in NPW.
• Fixed: Selection of a driver in NPW makes the Library Type and Floating Type to become empty.
• Fixed: "ERROR: fatal error: board.h: No such file or directory" error reported if building a newly created project

with no board support.
• Fixed: Library type is not changing correctly when using SDK Wizard.
• Fixed: SDKs for older LPCs failing to set CRP up correctly.
• Fixed: Outline view displays empty table header when selecting an SDK.
• Fixed: Issues when uninstalling an SDK plugin. Now "Installed SDKs" and "Install MCUXpresso SDK" views

are in sync and report the right installation status of an SDK.
• Fixed: On explicit include paths in the project setting, the include paths are mixed between asm and c type.
• Fixed: Outline view displays empty table header when selecting an SDK.
• Fixed: Null pointer exception on generating example XML.
• Fixed: Build error when using MCUXpresso IDE command line with non-existing include.
• Fixed: SDK command line: pre and/or post build steps options not available in example.xml file.
• Fixed: J-Link scripts needed by SDK examples are not copied correctly when installing the SDK from a folder.
• Fixed: MCUXpresso-linked projects compile errors on multicore platforms.
• Fixed: Compile errors reported on a project imported from a generate example.xml. Also fixed the CLI build

failing on the same example.xml scenario.
• Fixed: Unexpected memory usage reported (over 100% occupied memory) by Image Info.
• Fixed: Programming empty pages for ERASE_WO devices when flash hashing is enabled.
• Fixed: 'debug interface type' identification shown in the "Debug messages" console.
• Fixed: "Terminate" operation does not kill the redlinkserv.exe process.
• Fixed: "Terminate" button appears disabled after the first "Suspend" for PEMicro and J-Link debug connection.
• Fixed: J-Link auto selection results in not working connection.
• Fixed: Flash programming using J-Link via JTAG.
• Fixed: The running environment (PC/SP) for RAM applications is now properly initialized by the debugger

when using J-Link/PEmicro.
• Fixed: Debugger Console output stops working when debugging secure project.
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• Fixed: Error reported when SWO clock speed dialogue cancelled.
• Fixed: FreeRTOS tasks list not populated correctly in some situations.
• Fixed: SVD viewer shows up with empty peripherals list.
• Fixed: Live Variables: Unable to create expression with casts.
• Fixed: Global Variables: T0 remains -0 while moving the Graph to the right.
• Fixed: [Dark Theme] highlighting makes text unreadable.
• Fixed: [Dark Theme] Text is not visible for Blocked jobs in FreeRTOS.
• Fixed: [Dark Theme] Peripherals view - some registers have yellow background making it hard to read.
• Fixed: [Dark Theme] Line highlighting in editor makes variables text unreadable.
• Fixed: [Dark Theme] Display issue for the "Probes discovered" window on macOS.
• Fixed: [Dark Theme] Low contrast on text vs. background when a word is highlighted by having cursor

selection on it.
• Fixed: [Dark Theme] Manage SDK Components window is not updated.
• Fixed: [Dark Theme] Various improvements on Disassembly, Memory, Peripherals, headers in views, editor,

and git plugin.
• Fixed: [Dark Theme] Install plugin SDKs window shows white rectangles around icons.
• Fixed: [Dark Theme] Line number background is too bright.
• Fixed: [Dark Theme] Install MCUXpresso SDK view shows white background while selecting table headers.

1.18  Version 11.2.0 (July 2020)
• Upgraded: Eclipse version to 2019.12 (Eclipse Platform 4.14.0 /

CDT9.10.0).
• Upgraded: GNU ARM Embedded Toolchain to GCC9-2019-q4-major.
• Upgraded: GNU make 4.2.1 is now integrated on IDE on all OS-es.
• Upgraded: Version v8 of MCUXpresso Config Tools.
• Upgraded: FreeRTOS TAD synchronization with FreeRTOS 202002.00.
• Upgraded: newer SEGGER J-Link software (v6.80d).
• Upgraded: newer PEmicro plugin (v4.6.9).
• Added RT500 B0 support.
• Added flash programming support for QN9090/JN5189.
• Added KW37/KW38/K39 B0 support.
• Improvement: [RT500/RT600] Extended flash drivers to support boards potentially wired in a different way

from the EVKs with regard to the reset pin used for the external flash device.
• Improvement: [RT500/RT600] Flash erase performance of RT600 rev B0 flash driver (~30% speed increase).
• Improvement: 'Delete' option added for plugin SDKs. Now the removal option should be similar to the file

system SDKs.
• Improvement: Added Help -> "MCUXpresso IDE Save Info For Support" option intended to gather enough

information to help report an issue. User is encouraged to use this option when reporting an issue and to also
attach the generated zip file to help development team to easily trace the reported problem. Added:
– MCU IDE installation details
– Files from workspace
– Information about Installed SDK
– Workspace log file
– Content of the Console View

• Improvement: added new control to manage the maximum number of child expressions that are evaluated
in advance by the Live Variables service. This improves the Global Variables window responsiveness for
instance when large structures are displayed. New control available on Eclipse Preferences -> MCUXpresso
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IDE -> Debug Options -> "Number of subexpressions proactively evaluated by Live Variables service". Default
is 2 set as depth.

• Improvement: expressions added in Global Variables are now persistent between debug sessions.
• Fixed: Error reported while importing SDK example and changing to Newlib (semihost).
• Fixed: LinkerScript awareness reports fails on /DISCARD/ sections.
• Fixed: IDE freeze and high CPU power consumption while debugging with Segger debug probe and

disconnecting the USB cable.
• Fixed: SDK import project example copies wrong header file in the case of multiple files with the same name.
• Fixed: Unticking the "Redirect SDK PRINTF to C library printf" does not reset the ticking settings.
• Fixed: [LPC11U68] A modified register in peripherals view alters other registers.
• Fixed: [RT600] Debug error using LinkerServer if RT685 previously went to deep sleep state.
• Fixed: [RT600] Unable to use "Restart" for debug session on RT600.
• Fixed: [LPC43xx] "Wrong field format" displayed for SPI peripheral registers on LPC43xx.
• Fixed: [RT1170] breakpoint support for CM4.
• Fixed: "Hide Installed" within SDK installer view should be unchecked by default.
• Fixed: Include directory path for the proper newlib.h is missing when newlib-nano spec is used.
• Fixed: Global Variables showing negative timestamps after "Clear Data" is used.
• Fixed: Exception thrown after trying to delete a closed project.
• Fixed: SDK plugins generated with the IDE contain keywords of examples that are missing in the SDK

package.
• Fixed: ELF parsing issue which in some particular circumstances could cause incomplete flashing of

programs generated using user-defined linker scripts (for example, tfm SDK examples).
• Fixed: Linker script error related to "OVERLAY" keyword.
• Fixed: Internal error displayed when creating a new ldt file in MCUX.
• Fixed: Empty tooltip for "Global Variables" View when adding variables.
• Fixed: Linker script parsing error reported as: "missing ';' at '}' ".
• Fixed: Exception shown when renaming a project after a debug session ended.
• Fixed: Missing board picture when an SDK is selected within "SDK installer" on Ubuntu.
• Fixed: Removed board-related memories on "New Project Wizard" when "Empty board files" option is

selected.
• Fixed: issue when Global Variables list is empty when going into debug mode.
• Fixed: xpsr registers for which the values cannot be changed for Cortex M0 boards.
• Fixed: null pointer exception shown when displaying Globals Variable view in NonStopMode.
• Fixed: freeze reported when hovering over a large size symbol.
• Fixed: empty tooltip for Global Variables View when adding variables.
• Fixed: various UI widgets to correctly display the dark theme.
• Fixed: the issue when removed variables were continuing to plot data.
• Fixed: "Remove Selected Variables" always removes all added global variables. This was happening when

global variables were added in Global Variables view using "Add new expression".
• Fixed: Japanese/Chinese font issues on MCUXpressoIDE - this was fixed by the updated Eclipse version.
• Fixed: issue (hang) when displaying large structures while debugging.

1.19  Version 11.1.1 (March 2020)
• Fixed issue with file path handling when importing examples or creating new projects with certain SDKs

(previously made available as a hotfix to IDE v11.1.0 via Eclipse update system)
• Fixed issue that prevented text zooming in Editor View
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• Fixed issue that caused deletion of most compiler defines if the MCU package for a project was changed
• Updates to linker script file awareness, including

– Fixed issue handling situation where symbols are quoted
– Removed requirement for MEMORY command to provide access attributes

• Updates to map file awareness, including
– Fixed issue with handling of ld's PROVIDE keyword

• Fixed issue with linker script generation related to placement of symbols for .ARM.exidx section (which could
trigger issue with C++ exceptions)

• Restructured way eGIT plugin integrated into IDE (to allow updating by the user). Supplied version also
updated to v5.6.0

• Updates to allow LinkServer debug connections (ie CMSIS-DAP) to i.MX RT6xx "rev B" silicon. Note that
these changes mean that earlier i.MX RT6xx silicon can no longer be supported

• Updates to LinkServer debug to provide support for debugging Kinetis KE0x. Note that manual changes to
SDK 2.7.0 or earlier are required for this to be enabled

• Preliminary LinkServer support for i.MX RT1170 devices
• Fixed sector size issue with LinkServer flash driver for Kinetis KM3x devices
• Fixed issue that prevented launch configuration creation (and hence debug) for multicore projects for

preinstalled parts (LPC43xx and LPC54xxx)
• Fixed issue with Peripheral View incorrectly handling 32-bit bitfields within peripheral registers
• Fixed issue with Registers View such that modifying fields in xpsr could incorrectly modify other fields
• Added mechanism to Preferences to allow default reset settings used when creating SEGGER launch

configurations to be overridden for specific devices
• Updated integrated version of MCUXpresso Config Tools to v7.0.1

– TEE tool: Displays correctly inaccessible regions in "Memory attribution map" view
• Upgraded to a later version of the PEMicro plugin (v4.5.3)
• Upgraded to a later version of the SEGGER J-Link software (v6.62d)

1.20  Version 11.1.0 (December 2019)
• Upgraded underlying Eclipse Framework to 4.12.0.v201906 / CDT9.8.1
• Upgraded supplied GNU ARM Embedded Toolchain to GCC8-2019q3-update
• Added support for MCUXpresso SDK v2.7
• Upgraded integrated version of MCUXpresso Config Tools to v7
• New Welcome View, providing an improved out-of-box experience for new users. The IDE now also opens for

the first time at a larger default window size, improving usability without the need for resizing
• New "plugin SDK" system provides an easy-to-use mechanism for simplified installation and management of

MCUXpresso SDKs
• Reduced the code size of debug builds for SDK projects. This improvement is achieved by decreasing the

overhead of the assert() function, which is commonly called by SDK functions. This improvement has been
done by the addition of "-fmerge-constants" and "-fmacro-prefix-map" compiler options to project compiler
optimization settings

• Added support for more complex specification of dependencies between SDK components. This change now
allows some components (in particular, middleware ones) that previously could only be accessed through
SDK examples, to be added to projects and configured. Components can be added for new projects using the
new project wizard, or for existing projects via "Manage SDK Components". Note: this functionality requires
SDK 2.7

• Various enhancements to "Installed SDKs" View, including:
– New tabs provide easy access to the list of boards and devices that are installed into the IDE, in addition to

the actual SDKs. Right-clicking the menu on a board or device also allows the new project wizard (and, for
boards, the import example wizard) to be run
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– Detailed information on the contents of the selected SDK is now displayed in Outline View
– Improved loading of SDKs, including refreshing, improving performance, and fixing memory leaks
– Copy/paste of SDKs now allowed between View and OS filer, as well as between different IDE instances

• Fixed an issue with the sorting of boards in SDK wizards
• Fixed an issue with handling of combined secure / non-secure with multicore projects
• Fixed issue with "Manage SDK Components" removing &quot from C++ Symbols in .cproject file
• Various fixes and enhancements to SDK Editor / Creator, to support "user board SDKs" to act as an extension

to a standard MCUXpresso SDK
• Various fixes and enhancements to Image Info View. In particular:

– Further improvements to load times
– Added ability to double-click on a memory region in the Memory Usage tab and jump to that region in the

Memory Contents tab
– "Load" from project button now provides a drop-down to allow direct loading of info from multiple build

configurations into multiple Image Info Views
– Regular expressions are now supported in "Search..." box
– "Open 'main' symbol" button implemented on toolbar
– Improved support for projects outside the workspace

• Various improvements and fixes to map file awareness, including:
– Improved handling of C++ projects
– Fixed an issue with handling expressions containing parentheses

• Various improvements and fixes to linker script file awareness, including improved handling of libraries
specified in the script

• Various improvements to the managed linker script system:
– Standardized set of symbols now generated for sections
– Fixed an issue with LMA being incorrectly set in some circumstances for sections that do not have a real

load address (for example, .bss). Although this issue did not prevent the generated image from working, it
could cause, for example, erroneous information in Image Info View

– Plain load image functionality now supported for RT6xx devices
– LinkServer FreeRTOS debug config rodata now placed by script, when appropriate

• Increased default java memory settings (-Xms, -Xmx) in mcuxpressoide.ini file. The IDE is able to use up to 2
GB by default

• Windows build tools now provide 'mv' command
• Added MCUXpresso Dark Theme, providing better support for the tailored set of Views of the IDE being used

in dark mode
• Improved organization of MCUXpresso IDE preferences, in particular Debug related ones
• Project decorators implemented in Project Explorer View to indicate Master/Slave and Secure/Non-secure

projects
• Standardized graphing technology used by SWO Interrupt trace and by Global Variables View
• Improvements to LinkServer flash driver performance for many devices. Particularly, most flash drivers now

implement a "verify-same" hashing mechanism to remove the need to erase/reprogram when the memory
being programmed already has the required content. These changes can provide a noticeable improvement in
debug startup time, particularly when repeatedly debugging large, nonchanging images

• Required debug probe can now be selected by double-clicking it in the "Probes discovered" dialog
• Global Variables View now uses a checkbox system to select variables to be displayed in graphs within the

details pane
• Improved handling of certain variable types, along with signed versus unsigned variables, within the Global

Variables View
• Fixed an issue with the display of large arrays in Global Variables View with SEGGER and PEMicro debug

connections, when Live variables are enabled
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• Various fixes and enhancements to the Peripherals View, in particularly some registers being marked as
inaccessible when single-stepping

• Fixed an issue with Disassembly View going blank after Restart, with LinkServer debug connections
• Fixed an issue with flash programming with PEMicro probes when a filename or path contains a space
• Fixed various memory leaks triggered during debugging
• Fixed an issue with decoding the correct stack pointer to be used in Faults View
• When debugging secure / non-secure projects, you can now set breakpoints in CMSE functions and view the

source when breakpoints hit
• Reduced the RAM footprint of the FTFA_1K.cfx LinkServer flash driver, to prevent issues on some smaller

RAM devices that use this driver (for example, MKE14Z32)
• Additional and improved Linkserver connect scripts for RT10xx devices, which in particular reset the FlexRAM

sizes to default. Note: for some devices, these scripts are only picked up by default if you are using an
appropriate SDK 2.7

• Fixed an issue that could prevent LinkServer SWO trace and power measurement from working on Linux
platforms in some circumstances

• Fixed an issue with setting wirespeed in LinkServer launch configurations
• Cleaned up various layout issues with launch configuration editor
• Updates to product and installer to allow better compatibility with newer versions of Ubuntu. Note: our

supported Linux platforms remain Ubuntu 16.04 LTS and 18.04 LTS
• Updates to support new devices, including LPC551x, K32L2A and K32L2B families
• NXP LPC-LINK2 CMSIS-DAP firmware soft-loaded by IDE updated to v5.361
• Upgraded to a later version of the PEMicro plugin (v4.4.1)
• Upgraded to a later version of the SEGGER J-Link software (v6.54c)

1.21  Version 11.0.1 (August 2019)
• Updates to allow LinkServer debug connections (that is, CMSIS-DAP) to LPC55S6x "rev 1B" silicon and other

devices that implement "debug mailbox request" mechanism. Note: these changes mean that some pre-
production LPC55S6x silicon can no longer be supported

• Updates to support new devices, including K32L3A and i.MX RT1010
families

• Link to https://mcuxpresso.nxp.com now provided in New Project and Import SDK example(s) wizards,
improving accessibility for downloading additional SDKs

• Updates to map file awareness, including improvements to loading speed
• Fixed various issues with Image Info View
• Fixed issue with floating point options being incorrectly set for SDK example projects with C++ nature in some

circumstances
• Extended "include paths" indexer fix implemented in IDE v11.0.0 to also work with library projects
• Fixed issue with SDK multicore examples importing with managed linker script settings not being configured

correctly in some circumstances
• Fixed memory leak in Installed SDKs View when regeneration of part support info triggered
• Managed linker script mechanism now generates references to "CodeQuickAccess"", "DataQuickAccess" and

"RamFunction" input sections (required by some SDK examples/drivers) in default .data output section
• Fixed issue with Debug Shortcuts in QuickStart Panel incorrectly selecting attach/debug option in some

circumstances
• Fixed various minor issues with the GUI Flash Tool
• Fixed issue with Global Variables View slowing down debug launches with C++ projects
• Fixed addresses > 0x80000000 issue with Heap and Stack Usage View
• Fixed issue with Global Variables View graphs updating when target suspended
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• Fixed issue with Peripherals View with LPC17xx devices, particularly affecting display of certain enumerations
• Fixed issue with Peripherals View refresh. This could cause some registers to sometimes be erroneously

displayed as unavailable
• Fixed issue with LinkServer launch configuration wirespeed setting being ignored in some circumstances
• Updated the way the IDE autodetects installed SEGGER software. This is required due to changes SEGGER

have made to the default options of their Windows installer in v6.46 and later of their software
• Fixed issue with PEMicro and SEGGER implementations of live variables service (required to support live

update of globals in Global Variables View). This issue could provoke problems in some circumstances
when debugging via these probes including slow debug performance and failure to display locals inside the
Variables View

• Fixed issue with the display of large arrays when using PEMicro or SEGGER debug connections
• Fixed issue that could trigger an error when manually creating a J-Link launch configuration
• Upgraded to a later version of the PEMicro plugin (v4.2.5)
• Upgraded to a later version of the SEGGER J-Link software (v6.46k)
• Fixed build issue with MCUXpresso IDE v11.0.0 User Guide, which caused the last chapter ("Appendix –

Additional Hints and Tips") to be merged into the previous chapter ("Multicore Projects") as section 19.6
onwards. Actual content of manuals provided with IDE v11.0.1 is otherwise unchanged from v11.0.0 manuals

1.22  Version 11.0.0 (June 2019)
• Upgraded underlying Eclipse Framework to 4.10.0v201812 / CDT 9.6.0.
• Upgraded supplied GNU ARM Embedded Toolchain to GCC8 (2018q4-major)
• Windows version of the product now only runs on Win64 (IDE v10.3.1 and earlier ran on Win32 and Win64

platforms). This change has been driven by the fact that the Eclipse framework is now 64-bit only. [ Ubuntu
and macOS versions of the product already only ran on 64-bit platforms.]

• Updated version of "busybox", used on Windows to provide a UNIX-like layer for GCC tools to run under, to
"GNU MCU Eclipse Windows Build Tools" v2.12 (64 bit)

• Added support for MCUXpresso SDK v2.6
• Upgraded integrated version of MCUXpresso Config Tools to v6
• Revamped Develop Perspective with some new and additional views shown by default. Also decluttered by

removal of some less commonly used views. Most of the removed views can be added back via the new
'Analysis' menu

• New "Image Info" View improves and extends on the functionality previously provided by the "Symbols
Browser" view, giving the following analysis of a project build:
– Overall memory usage
– Content of memory regions
– Static call graph, including stack usage information

• New "Heap and Stack Usage" view provides the ability to track heap and stack usage during debugging of
baremetal projects

• Implemented "editor awareness" for linker map files, linker scripts, and linker script templates, providing
syntax coloring as well as navigation of file contents via the Outline view

• Improved display of components in the New Project Wizard and Managed Components dialog. Display of
different component types is now tabbed, with an additional summary of the components selected

• The New Project Wizard now opens the main source file in the Editor view after project creation
• When importing a single SDK example, the wizard now attempts to open the main source file in the Editor

view after project creation. This functionality can also be enabled when importing multiple examples through a
workspace preference

• Improved support for Cortex-M33 Secure / Non-Secure projects. Note: these improvements also require SDK
v2.6 for the MCU being targeted. Improvements include:
– Secure and Non-Secure projects are more closely linked from a build/project configuration point of view
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– Debugging Secure project automatically builds the Non-Secure project and program it into flash, before
launching the Secure project debug session

– Symbols for Non-Secure project automatically loaded into the debug session to allow user to step from
Secure world into Non-Secure (with source code visibility)

• Improved Launch Configurations for LinkServer. The main user impact is that this allows a more friendly way
of editing launch configuration settings. Some launch configuration functionality is now also provided in the
"standard" Eclipse/CDT tabs rather than in the LinkServer-specific manner. LinkServer Launch configurations
from older IDE versions are automatically converted to the new format

• New launch configuration tab (for all debug probe types) to allow loading of debug symbols from additional
images (in addition to the ones from the main image being debugged)

• Improvements to performance of single-stepping for LinkServer debug connections
• Implemented support for SWO Trace on Cortex-M33-based MCUs
• "Live Variables" functionality inside the Global Variables view is now supported using SEGGER J-Link and

PEMicro debug probes (in addition to LinkServer debug connections)
• FreeRTOS TAD functionality is now directly implemented within the IDE, rather than being a separate plugin

– Improved look and feel to better match rest of IDE
– Timeout period for FreeRTOS TAD increased, to help prevent reading of data failing on slow debug

connections. IDE preference is also added to allow timeout period to be changed
– Fixed issue with Runtime not showing when compiler optimizations are turned on
– Fixed issue with Timer List with FreeRTOS 10.2 release

• Fixed issue with IDE losing C library include paths. This did not prevent projects from building but meant that
indexer-related functionality reliant on these paths would not work correctly (for instance trying to open a C
library include file from the editor). This issue could also cause Newlib projects to sometimes appear to be
using Redlib include files. Note: Existing projects can be "fixed" using Tools->Fixup Parsers option on the
context-sensitive menu of the Project Properties view

• New projects now compile with the --fstack-usage option by default (needed for callgraph functionality in the
"Image Info" view)

• Quickstart Panel - Quick Settings menu can now indicate the current value for Debug Console, Floating Point,
and Library settings for current build configuration of selected project

• New projects now link with --cref option by default (increasing level of information provided in linker map files)
• Improved performance of installing/loading SDKs, largely by rearchitecting the way that SVD peripheral

definition files from the SDK are processed
• Installed SDKs view updated so that detailed information on the contents of the selected SDK is hidden by

default. Added a Hide/Show button to display the information when required
• SDK default folder mechanism was updated to install SDKs into an "02" subdirectory by default. This change

makes the SDKs installed by IDE v11.0.0 not visible to older versions of the IDE
• Improved ability to select debug console type (semihosting vs UART vs any preference specified by example

definition) when importing SDK examples. This improvement is useful when multiple projects are selected for
importing at the same time

• Tweaked code generated for main() by New Project Wizard for SDK projects. Now, the infinite loop at the end
of the function can be successfully single-stepped at the source level

• Fixed issue with default compiler options set by SDK New Project wizard when creating C++ projects. Such
projects are now also created with "cpp_config.cpp" file containing minimal implementations of the new/delete
operators and the verbose terminate handler for exceptions suitable for embedded use. This change brings
SDK C++ projects inline with C++ projects created with the New Project Wizard for preinstalled parts

• Some performance improvements when making a board selection in New Project Wizard and Import SDK
example(s) wizard

• Fixed issue with IDE incorrectly warning about overlapping memory regions when importing some SDK
examples, when the memory regions are actually just adjacent
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• Fixed issue with IDE being unable to show the context-sensitive menu in the Project Properties view for
makefile projects in some circumstances

• Fixed issue with handling of part support information for MCUs which have internal part support, but for which
an SDK exists and has been installed into the IDE

• Various updates and clean-up of icons. In particular, new icon for "LinkServer" now used in various places
instead of the general MCUXpresso IDE one

• Fixed issue with various tables displayed by IDE failing to display "..." to indicate truncation, when the amount
of text to display exceeds space currently available in the column

• Various fixes to SDK Editor / Creator
• Fixed issue with managed linker script mechanism when building primary projects linking in secondary

projects containing data with larger than normal alignment
• Fixed issue with managed linker script mechanism, which was causing some sections (such as .bss) to be

erroneously assigned unnecessary load addresses
• Fixed issue with section name wildcards used in managed linker script mechanism, which could prevent

__BSS/__DATA macros from working as expected in some circumstances
• On the Managed Linker Script page of Project Properties, IDE now autoconverts any "" directory separators

entered into "Script path" to Unix style "/" expected by the linker
• Added implementations of inverse hyperbolic functions to Redlib (acosh/acoshf, asinh/asinhf, and atanh/

atanhf)
• Improved Redlib definition of HUGE_VAL (and other related defines) in math.h. Also updated the way float_t

is defined
• arm_acle.h header file now on the search path for projects linking against Redlib (providing various ARM C

language extension intrinsics). Previously this was only available for Newlib-linked projects
• IDE now prioritizes use of IDE-supplied LinkServer flash drivers over any contained in installed SDKs (rather

than the other way around). This behavior can be reverted if necessary using an IDE workspace preference
• Fixed various issues with creation of multiple launch configurations for a particular build configuration in a

project
• Fixed issue with creation of launch configurations if previous attempt was canceled
• "Attach-only" debug sessions no longer trigger a build before starting the debug connection (as long as the

image has already built)
• Improved size and layout of Launch Configuration Selection Dialog (displayed when a project contains launch

configurations for multiple probe types)
• Fixed issue with the display of cycle counters in Registers View
• Fixed issue with GUI Flash Tool via LinkServer with LPC51U68

and KL28 MCUs
• Fixed issue with debug restart with QN9080 via LinkServer
• Fixed issue with LinkServer FreeRTOS thread awareness with Cortex-M33 based MCUs (and CM33 aware

versions of FreeRTOS)
• Implemented preliminary support for carrying out SWO Trace using CMSIS-DAP probes that implement

"CMSIS-SWO commands" (as opposed to the bespoke SWO support implemented by the LPC-Link2 CMSIS-
DAP firmware provided by NXP). This has currently only received limited testing using ULINKplus probes
with CMSIS-DAP v1.x.x firmware. Note: MCUXpresso IDE does not support the use of WinUSB endpoints as
provided by CMSIS-DAP v2.x.x firmware

• New IDE workspace preference to allow debug launch configurations for SEGGER J-Link probes to be
created with FreeRTOS thread awareness already enabled (off by default)

• Upgraded to a later version of the PEMicro plugin (v4.1.3)
• Upgraded to a later version of the SEGGER software (v6.44i)

RN00128 All information provided in this document is subject to legal disclaimers. © 2025 NXP B.V. All rights reserved.

Release notes Rev. 4 — 14 January 2025 Document feedback
31 / 44

https://www.nxp.com/pages/technical-documentation-feedback:WF-TECHNICAL-DOCUMENTATION-FEEDBACK


NXP Semiconductors RN00128
MCUXpresso IDE 24.12 Release Notes

1.23  Version 10.3.1 (February 2019)
• Improvements to support for i.MX RT600 MCUs
• Improvements to support for LPC5500 MCUs
• Added managed linker script and LinkServer debug support for i.MX RT1015
• Fixed issue with permissions within IDE installation directory on macOS and Ubuntu, which could cause

failure of FreeRTOS TAD plugin and also prevent installation and update of third-party plugins (for example,
from Eclipse Marketplace)

• Managed linker script mechanism now includes libgcc.a in the list of libraries to be linked against when
using Redlib (to resolve any runtime support functions generated by the compiler that have no specific
implementation in Redlib)

• Improved error checking in Memory Configuration Editor
• Managed Linker Script settings in Project Properties now more thoroughly checks alignment/region size when

calculating "Default" stack size - preventing potential issues with incorrect stack alignment
• Fixed issue with handling of "preinclude file" option when importing "Connectivity" example projects available

in SDKs for certain MCUs (such as Kinetis KW devices)
• Fixed issue with the SDK project wizards such that new projects could, in some circumstances, inherit

memory configuration information from a previous instance of the project wizard
• Fixed issue when importing SDK example projects that could cause projects to lose part of their configuration
• Fixed issue with "Select All" option failing when trying to add SDK Middleware components to a project with

some SDKs
• Improved handling of incorrect SDKs
• Fixed issue with Project Properties right-click menu which could cause it to fail to display for non-SDK projects
• Various fixes to SDK Editor / Creator
• Binary Utilities options are now disabled in certain cases for "CDT virtual nodes" in the Project Explorer view

(when such nodes are pointing to "files" that don't actually exist in the file system)
• Fixed issue in Fault Views which could cause certain fault registers to be displayed when they were not valid

for the current fault
• Fixed issue with the display of registers in their "natural" format in the Register view. This in particular means

that floating-point registers are now displayed in floating-point format by default instead of hex
• Fixed issue with the display of Registers View when the target is running
• Fixed issue with the handling of Peripherals View for SDK-based multicore MCUs
• Fixed issue with "Resume All" button being enabled even when all debug sessions are already running
• Enhanced Global Variables view to allow live variables update to be started/stopped whilst target is paused
• Fixed issue with LinkServer debug which could cause connection failures when debugging MCUs (such as

LPC8xx) which use the "-vc" debug option by default
• Fixed issue with LinkServer flash driver handling causing unnecessary memory accesses to be made, which

could cause flash programming failures with some very RAM-limited MCUs
• Fixed issue with LinkServer related to debugging applications in RAM, which could prevent correct setting of

breakpoints
• Fixed issue with LinkServer attaching to projects running in RAM
• Improved LinkServer debug connections to RT10xx devices to avoid occasional "wire ack" fault that could

occur when resetting MCU at the end of flash programming
• LinkServer debug connections now default to using the same Peripheral View service as used by SEGGER

and PEMicro debug connections. The LinkServer native service can currently be reenabled via a preference,
though this functionality will be removed in a future release

• Fixed issue that could cause LinkServer debug to occasionally slow down
• Improved LinkServer command line programming stability
• IDE now displays double precision registers in Register View with SEGGER and PEMicro debug connections

by default (where available on MCU)
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• Upgraded to a later version of the PEMicro plugin (v3.9.9)
• Upgraded to a later version of the SEGGER software (v6.42b)

1.24  Version 10.3.0 (December 2018)
• Major restructure of product installation structure to allow future minor product updates to be potentially

delivered via the Eclipse Software Update mechanism
• Upgraded supplied GNU ARM Embedded Toolchain to GCC7 2018q2-update
• Added support for MCUXpresso SDK v2.5.0
• Upgraded integrated version of MCUXpresso Config Tools to v5
• IDE now provides a workspace preference to allow the location of the SDK Drag&Drop installation folder

to be changed. However, by default, a central 'mcuxpresso' folder is still used. Current install location label
displayed in the "Installed SDKs" View

• IDE now generates part support information from installed SDKs into the workspace rather than into a central
'mcuxpresso' folder. This change improves behavior when multiple IDE instances are being used

• New implementation of the "Registers" View, allowing categorization of certain registers groups, and providing
access to additional CPU registers for PEMicro and SEGGER debug connections

• New "Faults" view compatible with LinkServer, PEMicro, and SEGGER debug connections implemented
(replacing the previous "vectpc" pseudo-register in Registers view for LinkServer debug connections). This
view decodes the fault registers and stack backtrace for a Cortex-M CPU to assist tracking down the cause of
hard faults and other processor exceptions

• SWO Trace is now supported via SEGGER J-Link and PEMicro debug probes (in addition to LinkServer LPC-
Link2 debug connections). Note: only recent versions of PEMicro probes support SWO

• NXP LPC-LINK2 CMSIS-DAP firmware soft-loaded by IDE updated to v5.224, providing noticeable
performance improvements over previous v5.183. For standard (debug+SWO) firmware, flash programming
speed increases of typically >10 % along with increases in SWO trace speed. For Non-bridged firmware
(debug only), flash programming speed increases of typically >20 %

• Project Explorer View enhanced to emphasize currently selected project, along with displaying its current build
configuration

• Editing Memory Configuration for projects is now done in place rather than spawning a separate editing dialog
• IDE now only creates a debug launch configuration for the current build configuration when a project is

debugged (if one does not yet exist), rather than for all build configurations
• New SDK creator wizard to create a "board SDK" from an existing project (with settings modified using the

MCUXpresso Config Tools). This "board SDK" can then be used to create new projects for custom boards
• Package associated with an SDK project can now be modified via the MCU entry of the "Project Settings"

virtual nodes of the project in the Project Explorer view
• IDE now supports additional build configurations being specified in SDK example definition files
• Added Linux Tools Libhover to preinstalled plugins (providing tooltips for standard C library calls)
• Upgraded to a later version of the PEMicro plugin (v3.8.3)
• Upgraded to a later version of the SEGGER software (v6.40)
• Updated FreeRTOS TAD plugin to v1.0.8

– Support heap using Newlib (identified as heap #6)
– Support FreeRTOS 10.1.1
– Fix highlight of free section in Heap Usage view

• Windows version of IDE now uses "busybox" (from "GNU MCU Eclipse Windows Build Tools" project), to
provide a UNIX-like layer for GCC tools to run under. Previous releases used the "msys" package

• Modified order of entries added to the path of the local shell when building projects under Windows - providing
small improvement in build speeds

• Additional LinkServer flash drivers provided for RT1060 and RT1064
• Preliminary LinkServer support for LPC55xx devices
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• Added basic support for Cortex-M33 secure projects
• Added support for Cortex-M33 No DSP variant
• LinkServer debug executable now allows probe selection by serial number (mainly intended for command-line

flash programming operations)
• Redlib updates

– Fixed snprintf()/vsnprintf() to prevent hard fault when NULL buffer passed
– Fixed issue with number sequences generated by rand()

• Made ordering of C Libraries in dropdown lists consistent across various menus
• Allow the user to choose only valid FPU settings in the Architecture tab of Project Settings
• "Quick Settings" option now allows reconfiguring multiple projects (where projects have compatible settings)
• Fixed issue that could cause a project to lose modifications to its memory configuration
• Grouped SDK actions under the new "SDK Management" entry of the Project Explorer pop-up menu
• Fixed issue that could cause the list of associated SDK components of a project to be lost
• Fixed issue with sorting of boards in SDK project wizards not taking any current selection into account
• Fixed issue with default peripherals.c/h files being automatically (and incorrectly) added during SDK example

import
• Fixed issue with Import of >1 SDK examples sometimes failing to correctly pick up some IDE default settings
• Fixed issue with SDK Project Component Manager when adding components with conditional sources to an

existing project
• Improved handling of C library family setting when importing multiple SDK examples
• Fixed issue that could cause the IDE to block when requested to change the SDK associated with a project
• Fixed issue with SDKs becoming unusable after canceling an unzipping operation
• Fixed issue with SDK New Project Wizard when no board selected which could cause wrong header files to

be generated
• Fixed issue with SDK New Project Wizard such that the main.c file is always included the

BOARD_InitDebugConsole() call even when the debug console component is not selected
• Fixed issue with handling of derived peripherals containing '_' in name
• Implemented partial workaround for an underlying Eclipse issue that can cause a "Target Not Available" dialog

when starting a debug session with the Disassembly view open
• Fixed issue with SEGGER launch configurations failing to reset MCU after programming flash
• Fixed issue with launch configurations created using standard Eclipse functionality, as opposed to

automatically created using MCUXpresso IDE
• Enhanced handling of additional bespoke launch configurations
• Fixed issue with sorting in the Probe selection dialog
• Fixed a long-standing issue with LinkServer launch configuration tabs changing order every time the launch

config editor is open
• Fixed issue that could cause the launch configuration selection dialog to be displayed twice in some

circumstances
• Fixed a longstanding issue that prevented Instruction Trace and SWO Trace from being used together
• Fixed issue with Instruction Trace Config view not correctly loading saved configuration files
• GUI Flash Tool now automatically selects the highlighted binary file from Project Explorer View

1.25  Version 10.2.1 (July 2018)
• Fixed issue in New Project Wizard when switching between a board and a generic device (or vice versa)
• Fixed issue with floating-point settings when importing SDK example projects for Cortex-M7-based MCUs
• Fixed issue with notification of missing dependencies when Add/Remove Component used with SDK v2.4.0

packages
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• Improved options to handle part selection when project importing in cases where the associated SDK is not
installed

• Fixed issue that could prevent a renamed project from being debugged in some circumstances
• Resolved various issues with user interface of GUI Flash Tool
• Resolved issue with workspace preferences when trying to configure the Debug perspective to be used for

debugging projects (instead of the default Develop perspective)
• Improved reliability of LinkServer debug sessions via enhancements to the way the IDE connects to the server

process, as well as enhancements in the server itself
• Improved the display of the LinkServer "RedlinkServer" console in the IDE
• Fixed issue with LinkServer "Disconnect behavior" always using "cont", even when configured to use another

disconnect option
• Option to terminate debug session added LinkServer error dialog in the IDE
• Fixed issue with handling of number formats for entries in Global Variables view
• Live Global Variable graphing no longer inserts spurious zero entry when target paused
• Fixed issue with enumerated bit field handling in the Peripheral Register viewer
• Fixed issue with the display of PriMask, BasePri, FaultMask, and Control special registers in the Registers

view for LinkServer debug sessions. This change also now allows these registers to be edited
• Fixed issue with LinkServer erroneously setting VTOR in some circumstances after programming flash
• Fixed issue with zoom function on SWO Interrupt Trace view
• Fixed issue with the Instruction Trace view, which could prevent profile information from being displayed in

source and disassembly views in some circumstances
• Fixed issue with Instruction Trace Config view, which prevented a modified configuration from being saved
• Preliminary LinkServer SPI flash drivers that self-configure using JEDEC SFDP information read from the

device are now included for i.MX RT1020 (QSPI) and RT1050 (QSPI and HyperFlash)
• Example device-specific flash driver projects provided for i.MX RT1020 and RT1050. These can be used as

a starting point for writing flash drivers for custom boards fitted with flash devices that do not support SFDP
information

• Updated FreeRTOS TAD plugin to v1.0.6
– Fixed issues with Pause button
– Added more verbose log for determining heap type
– Removed problematic heap identification from available variables

• Fixed issue that prevented the PEMicro plugin updating from the PEMicro update server
• Upgraded to a later version of the PEMicro plugin (v3.5.6)
• Upgraded to a later version of the SEGGER software (v6.32h)

1.26  Version 10.2.0 (May 2018)
• Upgraded Eclipse to Oxygen.3a / CDT 9.4.3. Amongst other improvements, this upgrade typically delivers a

noticeable increase in build speeds
• Upgraded supplied GNU ARM Embedded Toolchain to GCC7(2017q4-major)
• Upgraded integrated version of MCUXpresso Config Tools to v4.1
• Pro Edition discontinued. All IDE functionality is now enabled out of the box without any further activation or

purchase
• macOS version of product now fully 64-bit
• The Quickstart Panel was redesigned and now provides direct access to various operations for specific debug

solutions
• Added support for project Virtual Nodes in Project Explorer View, providing improved access to project

information and settings
• Added support for MCUXpresso SDK v2.4.0
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• Improved handling of the relationship between a project and its associated SDK package. For instance, the
user can now select an appropriate alternate installed SDK package if the originally associated SDK is no
longer installed

• Fixed issue with handling of non-Latin characters in username when creating SDK support folders
• SDK-based projects can now be converted to have "local SDK part support", allowing improved project

sharing. Such projects no longer require the full associated SDK to be installed in order to build/debug.
• SDK Documentation now accessible from within Installed SDKs View
• Enhanced accessibility of SDK Manifest information directly from within IDE Views
• The naming scheme used when importing SDK example projects was simplified, leading to shorter, more

legible filenames. This change helps avoid filename length issues when building projects on Windows.
• Include paths added on SDK project creation are now created project relative (reducing the size of the -I

options passed to gcc), except in the case where "copy sources" is deselected.
• Projects can now be imported into a workspace by dragging and dropping a folder (or zip) containing one or

more projects into the Project Explorer View
• Projects can also be exported by dragging from the Project Explorer View directly to an OS filer window
• Added support for refreshing projects to pull in files from a newer SDK than the one they were created with
• Enhanced display of SDK components in dialogs such as the New Project Wizard by allowing full-height

scalable columns
• Fixed a minor issue with the semihosting hard fault handler generated by project wizards, failing to set the

return value correctly
• Fixed an issue with the SDK new project wizard failing to set some compiler options correctly. This issue

caused increased project build size, as the linker did not remove by default unused functions in project
sources.

• Projects created against SDK v2.4.0 packages now link with the "--sort-section=alignment" option (generally,
unless overridden by SDK settings)

• Improved structure and content of static library projects created by the SDK new project wizard
• Enhanced support for project local LinkServer debug scripts
• Added support for project local LinkServer flash drivers
• Global data placement override option added to Managed Linker Script properties. This option allows global

data to be located in RAM regions other than the first listed in the memory configuration
• Managed Linker Script properties were enhanced to allow user-specified input sections to be listed in specific

memory regions in the generated linker script
• Managed Linker Script page in Project Properties reorganized to give a better layout of related options
• Fixed an issue with validation of heap and stack region sizes on the Managed Linker Script page in Project

Properties
• Support for "Plain load images" was added to the managed linker script mechanism - for use with LPC540xx

MCUs. This change allows an image to be placed into flash but relocated to RAM by the bootrom for
execution

• Instruction Trace functionality now available with PEMicro and SEGGER debug connections, as well as with
LinkServer connections

• New "GUI Flash Tool", replacing and extending the functionality previously provided by the LinkServer GUI
Flash Programmer. The new tool also supports use with PEMicro and SEGGER debug connections, as well
as LinkServer connections

• Global Variables View now offers the ability, with LinkServer debug connections, to display a live trace of
values, either as text or graphically

• Memory addresses can now be added as expressions to the Global Variables View
• Fixed various issues with the Peripheral Register viewer, including incorrect display of peripherals defined

using the SVD "cluster" tag, and failure to display certain bitfields correctly. Also, the bit field display ordering
within registers is now identical for all probe types

• Enhanced filter mechanism provided by the Peripheral Register viewer
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• For LinkServer and SEGGER debug connections, a hardware breakpoint is now used by default (where
Cortex-M hardware allows) for the default temporary breakpoint on main(). This change improves support for
debugging images that are relocated into RAM at boot time

• Fixed an issue with LinkServer debug connections causing the Debug View to display "(Stopped)" in thread
status (even when running) when FreeRTOS thread awareness was not in use

• Fixed an issue with LinkServer's "vectpc" pseudo-register in the Register View (used to provide CPU status
information when exceptions such as hard faults are triggered)

• Further improvements to the performance of standard LinkServer semihosting
• "Mailbox semihosting" mechanism is now available for images linked with the Redlib C library and debugged

via a LinkServer debug connection. This offers a major increase in bandwidth/performance compared to
standard, breakpoint-based semihosting, as the target is no longer halted to transfer data. It requires the
image to be linked against a new Redlib variant, and comes at the cost of a small increase in code size and
RAM requirements

• New Terminal View is available, allowing UART output from the target MCU to be displayed within the IDE
rather than requiring a separate host terminal application

• Removed automatic definition of bitband memory aliases in the LinkServer debug connection on Cortex-M3/
M4/M7 parts, as these definitions could prevent debugging in situations where a project contained similar
regions in its memory configuration

• LinkServer SPIFI flash drivers that self-configure using JEDEC SFDP information read from the device are
now included for the LPC18xx, LPC43xx, LPC546xx, and LPC540xx families

• LinkServer QSPI flash driver provided for MIMXRT1050-EVK and EVKB boards. Note: these boards require
modification to use the QSPI device rather than the default HyperFlash device

• Upgraded to a later version of the PEMicro plugin (v3.5.3)
• Upgraded to a later version of the SEGGER software (v6.32a)
• Updated SEGGER gdbserver detection on macOS / Linux to take into account changes made by SEGGER to

filenames on these platforms (in J-Link v6.30 and later)
• Added the LPC804 MCU to pre-installed part support
• Extended the Eclipse headless build mechanism to use the environment variable

"MCUXPRESSOIDE_SDK_INSTALL" to point to the SDK install directory (primarily to support use of build
servers)

• Optional, anonymous usage information is now collected by the main IDE, as well as the integrated Config
Tools

• Updated the FreeRTOS TAD plugin to v1.0.4. Changes include:
– Fixed Heap 5 issue with displaying large free blocks
– Fixed Heap 5 issue with calculating wrong size of heap
– Fixed issue with task stack showing overflow when usStackDepth is greater than 2048
– Fixed a heap identification issue
– Fixed an issue with Queue View when no queue has been registered

1.27  Version 10.1.1 (December 2017)
• Fixed an issue seen when importing a single SDK example, in which the IDE defaults could, in some

circumstances, override example-specific settings
• Fixed an issue with SDK example import failing to set the correct memory definition in a generated project.

The issue occurred when there was an example-specific memory configuration and also one in the manifest
for the board itself

1.28  Version 10.1.0 (November 2017)
• MCUXpresso Config Tools now integrated within the IDE, for use with SDK-based projects
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• Upgraded supplied GNU ARM Embedded Toolchain to GCC 6 update 2
• Increased default max heap space of Eclipse environment requested by the IDE
• Additional Eclipse Features supplied within the IDE installation:

– Eclipse Marketplace Client
– Eclipse XML Editors and Tools
– Eclipse XPath Developer Tools
– Eclipse XSL Developer Tools

• Fixed issue with Memory Configuration Editor when all memory blocks deleted
• Parallel building of projects is now also enabled for "release" build configuration (previously it was only

enabled for "debug" builds)
• Managed linker scripts now generate _HeapSize and _StackSize symbols when configured for "MCUXpresso

Style" Heap and Stack placement
• Managed linker scripts now generate _image_start, _image_end, and _image_size symbols. These symbols

give the location and size of the main text block (including initial values of RW data sections)
• Added "Information" option to the Binary Utilities menu to run the arm-eabi-readelf utility
• Enhancements to SDK handling of the IDE, for SDK v2.3.0 packages and manifests
• SDK default folder mechanism was updated to provide a versioning subdirectory. This change prevents clash

of installed SDKs if IDE v10.0.x is used after SDKs are installed into IDE v10.1.0
• Improvements to Installed SDKs View. IDE now shows which manifest is in use and the handling of

decorators (icons) to reflect SDK state has been enhanced
• Improved handling of imported project when no matching SDK part support installed
• Provided Delete option for when a newer version of a specific SDK is imported and replaced an older version
• New SDK Add/Remove Component Manager allowing addition and removal of drivers, RTOS, and many

Middleware components to existing projects. Note some functionality is only available when used with SDK
v2.3.0 packages

• SDK new project wizard now provides Middleware component selection (for use with SDK v2.3.0 packages)
• IDE now supports SDK component categorization (where provided by SDK)
• Projects using linked references to SDKs sources now export with only relative include paths (to an

environment variable) so simplifying project sharing
• Improved interaction between SDK and IDE over project settings (for SDK v2.3.0 packages). This change

allows, for instance, better synchronization in the Advanced setting page when importing examples. Also
allows for projects that require specific settings such as Newlib or floating point printf

• Enhancements to the SDK Wizard Advanced Setting page, including
– Redirect printf/scanf to ITM option now disabled for Cortex-M0+ cpu in multicore MCUs
– C++ project selection in project wizard now prevents selection of Redlib

• Improved multicore SDK project handling, including enhancements within the SDK new project and import
example(s) wizards

• Enhancements to SDK handling allowing removal of the "Reload" part support function, leaving only
"Recreate"

• Filter functionality for Importing SDK Examples was enhanced. Now it filters on any part of the example path,
not just the leaf name of the example

• New Project Wizard improved to better handle situation where the user uses the "back" button
• Fixed issue with export of examples.xml file
• Fixed issue that in some circumstances importing multiple examples could cause some projects to fail to build
• Changes made to the SDK default board button position and its selection in New Project Wizard
• Pressing SHIFT at the same time as clicking the Debug option of the Quickstart Panel now forces a debug

probe rediscovery
• Fixed issue with IDE failing to display Peripheral View for a peripheral that is enabled but where some, but not

all, of the registers are not accessible (for instance SPI peripheral in target mode on Kinetis parts)
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• Added an alternate ("non-enhanced") Peripheral View service for use with LinkServer. It works in the same
way as the Peripheral View services provided for SEGGER and PEMicro debug connections. The alternate
service is disabled (via a preference) by default, as it is largely intended for internal testing purposes

• Fixed issues with Peripheral View for SEGGER and PEMicro debug probes, plus LinkServer in non-enhanced
peripheral mode:
– LPC17xx and LPC12xx peripherals can now be displayed
– Display state is no longer lost when execution is restarted
– Selecting a peripheral register value no longer triggers an error

• The semihosting HardFault handler is now automatically included in new/imported SDK projects. This change
allows semihosted applications to continue execution without debug tools attached

• AllStop mode option is now saved if a LinkServer launch configuration is created manually for the connected
probe (as opposed to using the Quickstart Panel Debug option)

• LinkServer multicore debug auto-core select now works correctly for Cortex-M0+ core on LPC541xx MCUs
(using preinstalled part support)

• Fixed issue with deleting JTAG/SWD configurations (for LinkServer connections, typically to multicore MCUs)
actually deleting the launch configuration files

• Fixed issue with Register View of the IDE when debugging multicore MCUs such that it displayed Cortex-M4
registers, but referenced them as being for the Cortex-M0+

• For LinkServer debug sessions, failed debug sessions now report specific session that failed (useful when
debugging multiple targets)

• Various functional enhancements to LinkServer GUI flash programmer. The dialog window is now resizable
• Fixed LinkServer (redlinkserver) script TIME function on macOS and Linux. Also corrected time resolution for

this function on all 3 host platforms
• Fixed clock setup issue with LinkServer LPC5411x and LPC546xx flash drivers, which could occasionally

cause programming failures. This fix also provides a noticeable increase in programming performance on
these parts

• Upgraded to a later version of the SEGGER software (v6.20d)
• Upgraded to a later version of the PEMicro plugin (v3.1.8)
• Enhanced gdbserver console for SEGGER debug connection to quote invoked J-Link command when path

contains spaces
• Added support for Environment variables in JLink options
• Improved SEGGER server handling to link consoles created to project being debugged
• Improved SEGGER debug reset handling
• Improved automatic LPC MCU part matching mechanism for PEMicro debug launch configurations
• Added LPC802 MCU to preinstalled part support
• Added LPC8N04 MCU to preinstalled part support

1.29  Version 10.0.2 (July 2017)
• Fixed an issue where an MCU provided in both SDK and preinstalled support could erroneously reselect part

support for a project from the wrong source. Example of such MCU: LPC5411x
• Solved an issue with attempting to install a non-IDE-compatible SDK into a nondefault location
• Solved some issues with creating projects in nondefault locations
• Fixed an issue with the Properties View displaying information for the wrong device in some circumstances

(for preinstalled parts)
• Fixed an issue with incorrect dependency selection in project wizards in some circumstances when switching

between boards
• It is now possible to create makefile projects for SDK MCUs
• Enhanced the Memory Configuration Editor to give an error when there is no RAM defined for a project
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• Enhanced the Heap and Stack Editor to allow heap size to be set to zero
• Added a "Create Srecord" option to the Binary Utilities menu
• Implemented a port autodiscovery mechanism for LinkServer, SEGGER, and PEMicro debug sessions, to

improve concurrent debug session behavior
• Improved editing of launch configurations via double-click, and also improved their presentation in the Project

Explorer
• Fixed some issues with manually generated launch configurations (including non-stop setting)
• Added probe icons in the "Launch Configuration Selection" dialog
• Fixed a failure to display registers for certain peripherals in the Peripheral View for SDK-based MCUs
• Resolved an issue with Peripherals failing to display for register names containing a '_' character
• Fixed some issues with the semihosting console:

– Space/newline characters were occasionally lost when printing only a single character
– Empty strings were sometimes mishandled

• Fixed an issue with "Terminate All" in some circumstances when multiple debug connections were active
• Improved state synchronization between the blue debug button on the toolbar and the one on the Quickstart

Panel, particularly when moving between tabs
• Stopped the Registers View triggering a null pointer error when an n/a value was clicked
• Fixed a LinkServer issue with the setting of watchpoints when debugging Cortex-M0/M0+ based MCUs
• Fixed an issue with auto-core selection when debugging triple-core LPC43xx devices
• Fixed an issue with the display of performance counters in LinkServer SWO Trace
• LinkServer FreeRTOS Thread Aware Debug is now only available in all-stop debug connections, not in non-

stop. However, FreeRTOS TAD Views are still available for non-stop connections
• Fixed an issue with LinkServer debug connections losing target control when an attempt was made to use

more hardware breakpoint units than the MCU supports
• Fixed an issue where peripherals could fail to be displayed in LinkServer debug connections in some

circumstances
• Enhanced LinkServer support for debugging RAM-only projects
• Reduced the startup time for LinkServer debug sessions
• Improved the performance of LinkServer semihosting
• Enhanced LinkServer to allow restricted parsing of the MCU debug AP bus, allowing support for MCUs with

incomplete Coresight implementations
– Debug of Kinetis KL28 MCUs is now supported via LinkServer

• Fixed an issue with MCUXpresso IDE attempting to use JTAG instead of SWD connections for certain
CMSIS-DAP probes with multicore MCUs missing hardware JTAG support

• Fixed an issue with MCUXpresso IDE in some circumstances trying to make a LinkServer multicore debug
connection to a secondary core without correctly selecting the core

• Fixed the Save button for the LinkServer SWO Trace ITM console
• LinkServer no longer leaves the CPU of the MCU in debug mode when terminating a debug connection (so

semihosted I/O now hard faults, rather than causing the CPU to enter debug)
• Made various improvements to the LinkServer GUI flash programmer
• Upgraded to a later version of the SEGGER software (v6.16b)
• Improved SEGGER support, including:

– Support for concurrent debugging via multiple SEGGER probes
– Improved SEGGER launch configuration UI, providing more options directly and adding a new Startup tab
– Fixed an issue with terminating a debug session when multiple SEGGER debug sessions are active
– Enhanced automatic part selection for SEGGER debug connections of preinstalled MCUs
– Changed the SEGGER device dropdown to accept free-form text
– Fixed an issue seen when debugging with an external SEGGER GDB server, which triggered telnet console

issues
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– SEGGER server errors now appear in the dialog when debug connections fail
– Fixed a server shutdown when a debug session was terminated to leave the board in a running state

• Upgraded to a later version of the PEMicro plugin (v3.0.3)
• Improved PEMicro support, including:

– Support for concurrent debugging via multiple PEMicro probes
– Fixed an issue with the Quickstart Teminate/Build/Debug button when used with PEMicro debug

connections
• Various other bug fixes and UI tweaks, including:

– Quickstart Panel floating-point options made device-specific
– Added a link to the Error Log View in the invalid SDK exception error dialog
– Fixed a LinkServer semihosting input issue (for example, scanf needing extra carriage returns)
– Fixed an issue with handling the LPC5411x SDK versus preinstalled support board selection
– Removed non-stop Probe Discovery options that had been presented for the LinkServer GUI Flash

Programmer Mass erase function
– Added an option to the Project Wizard to allow import of "miscellaneous" files from SDK project structure

and SDK components into the generated project
– Fixed an issue with library project creation pulling in startup code

• Changed the name of the Linux installer from .run to .bin to avoid issues with the Flexera download system
• Fixed the Linux PEMicro udev rules setup for users who have Kinetis Design Studio installed
• Documentation fixes and minor enhancements to reflect product changes
• Enhancements to LPC84x support, including ROM divide support in the new project wizard
• Added PN7xxxx to the list of preinstalled MCUs
• Added QN9080-specific LinkServer debug support

1.30  Version 10.0.0 (March 2017)
• First release

2   Revision history

Document ID Release date Description

RN00128 v.4 14 January 2025 24.12 - major release version update. See chapter 2 from
the MCUXpresso IDE User Guide for details.

RN00128 v.3 1 July 2024 11.10.0 - major release version update. See chapter 2 from
the MCUXpresso IDE User Guide for details.

RN00128 v.2 17 January 2024 11.9.0 - major release version update. See chapter 2 from
the MCUXpresso IDE User Guide for details.

RN00128 v.1 31 July 2023 11.8.0 - major release version update. See chapter 2 from
the MCUXpresso IDE User Guide for details.

Table 1. Revision history
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Legal information

Definitions
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representations or warranties as to the accuracy or completeness of
information included in a draft version of a document and shall have no
liability for the consequences of use of such information.

Disclaimers
Limited warranty and liability — Information in this document is believed
to be accurate and reliable. However, NXP Semiconductors does not give
any representations or warranties, expressed or implied, as to the accuracy
or completeness of such information and shall have no liability for the
consequences of use of such information. NXP Semiconductors takes no
responsibility for the content in this document if provided by an information
source outside of NXP Semiconductors.
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lost profits, lost savings, business interruption, costs related to the removal
or replacement of any products or rework charges) whether or not such
damages are based on tort (including negligence), warranty, breach of
contract or any other legal theory.
Notwithstanding any damages that customer might incur for any reason
whatsoever, NXP Semiconductors’ aggregate and cumulative liability
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accordance with the Terms and conditions of commercial sale of NXP
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make changes to information published in this document, including without
limitation specifications and product descriptions, at any time and without
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safety-critical systems or equipment, nor in applications where failure or
malfunction of an NXP Semiconductors product can reasonably be expected
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damage. NXP Semiconductors and its suppliers accept no liability for
inclusion and/or use of NXP Semiconductors products in such equipment or
applications and therefore such inclusion and/or use is at the customer’s own
risk.

Applications — Applications that are described herein for any of these
products are for illustrative purposes only. NXP Semiconductors makes no
representation or warranty that such applications will be suitable for the
specified use without further testing or modification.
Customers are responsible for the design and operation of their
applications and products using NXP Semiconductors products, and NXP
Semiconductors accepts no liability for any assistance with applications or
customer product design. It is customer’s sole responsibility to determine
whether the NXP Semiconductors product is suitable and fit for the
customer’s applications and products planned, as well as for the planned
application and use of customer’s third party customer(s). Customers should
provide appropriate design and operating safeguards to minimize the risks
associated with their applications and products.
NXP Semiconductors does not accept any liability related to any default,
damage, costs or problem which is based on any weakness or default
in the customer’s applications or products, or the application or use by
customer’s third party customer(s). Customer is responsible for doing all
necessary testing for the customer’s applications and products using NXP
Semiconductors products in order to avoid a default of the applications
and the products or of the application or use by customer’s third party
customer(s). NXP does not accept any liability in this respect.

Terms and conditions of commercial sale — NXP Semiconductors
products are sold subject to the general terms and conditions of commercial
sale, as published at https://www.nxp.com/profile/terms, unless otherwise
agreed in a valid written individual agreement. In case an individual
agreement is concluded only the terms and conditions of the respective
agreement shall apply. NXP Semiconductors hereby expressly objects to
applying the customer’s general terms and conditions with regard to the
purchase of NXP Semiconductors products by customer.

Export control — This document as well as the item(s) described herein
may be subject to export control regulations. Export might require a prior
authorization from competent authorities.

Suitability for use in non-automotive qualified products — Unless
this document expressly states that this specific NXP Semiconductors
product is automotive qualified, the product is not suitable for automotive
use. It is neither qualified nor tested in accordance with automotive testing
or application requirements. NXP Semiconductors accepts no liability for
inclusion and/or use of non-automotive qualified products in automotive
equipment or applications.
In the event that customer uses the product for design-in and use in
automotive applications to automotive specifications and standards,
customer (a) shall use the product without NXP Semiconductors’ warranty
of the product for such automotive applications, use and specifications, and
(b) whenever customer uses the product for automotive applications beyond
NXP Semiconductors’ specifications such use shall be solely at customer’s
own risk, and (c) customer fully indemnifies NXP Semiconductors for any
liability, damages or failed product claims resulting from customer design and
use of the product for automotive applications beyond NXP Semiconductors’
standard warranty and NXP Semiconductors’ product specifications.

Translations — A non-English (translated) version of a document, including
the legal information in that document, is for reference only. The English
version shall prevail in case of any discrepancy between the translated and
English versions.

Security — Customer understands that all NXP products may be subject to
unidentified vulnerabilities or may support established security standards or
specifications with known limitations. Customer is responsible for the design
and operation of its applications and products throughout their lifecycles
to reduce the effect of these vulnerabilities on customer’s applications
and products. Customer’s responsibility also extends to other open and/or
proprietary technologies supported by NXP products for use in customer’s
applications. NXP accepts no liability for any vulnerability. Customer should
regularly check security updates from NXP and follow up appropriately.
Customer shall select products with security features that best meet rules,
regulations, and standards of the intended application and make the
ultimate design decisions regarding its products and is solely responsible
for compliance with all legal, regulatory, and security related requirements
concerning its products, regardless of any information or support that may be
provided by NXP.
NXP has a Product Security Incident Response Team (PSIRT) (reachable
at PSIRT@nxp.com) that manages the investigation, reporting, and solution
release to security vulnerabilities of NXP products.

NXP B.V. — NXP B.V. is not an operating company and it does not distribute
or sell products.

Trademarks
Notice: All referenced brands, product names, service names, and
trademarks are the property of their respective owners.
NXP — wordmark and logo are trademarks of NXP B.V.
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